LEVEL 2

)
S
@\
U
O
s
MO
=
=
Mo
aC
el ol

\




PracTticaL PHoTOsHOP CC 2015, LEVEL 2

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo



PracTicAL PHoTOSHOP® CC 2015
LEVEL 2

Donald Laird
Barbara Zukin Heiman, Ph.D.
Windsor Green
Corrine Haverinen
Marilyn P. Kelly, Ed.D.

Mike Starkey



Practical Photoshop® CC 2015, Level 2
Copyright © 2011-2016 by Donald Laird, Barbara Zukin Heiman, Windsor Green, Corrine Haverinen,
Marilyn P. Kelly, and Mike Starkey

Practical Photoshop
PO Box 195, Vineburg, CA 95487

Find us on the Web at http://www.practical-photoshop.com.
For inquiries or to report problems or errors, please send an email to bheiman@practical-photoshop.
com.

Notice of Rights

All rights reserved. No part of this book or the accompanying electronic files may be reproduced
or transmitted in any form or by any means—electronic, mechanical, photocopying, recording, or
otherwise—without the prior written permission of the publisher.

Trademark

Adobe® Photoshop® and Adobe® Bridge® are registered trademarks of Adobe Systems, inc. in the United
States and other countries.

Notice of Liability

The information in this electronic book are distributed on an “as is” basis, without warranty. While
every precaution has been taken in the preparation of this book, none of the authors shall have any
liability to any person or entity with respect to any liability, loss, or damage caused or alleged to be
caused directly or indirectly by the instructions contained herein, or by the computer software or
hardware products described herein or provided on the website that accompanies the book.



PracTticaL PHoTOsHOP CC 2015, LEVEL 2

TABLE OF CONTENTS — SUMMARY

TUTORIAL 1: OVERVIEW & GUIDELINES eceeceecsecsessecsecsacsacsscssessessessessessessessessessassassassane 1
TuTORIAL 2: LIBRARIES & CAMERA RAW..ccrerrerrecracracsaccacnacnacnsensensensessessessessessassassanss 17
TUTORIAL 3: A FIRST LOOK AT IMIASKS ceuterreresesesansenseccncseecaecsessensessessessessessessassanes 36
TUTORIAL 4: TYPE & SMART OBJECTS cceeucracceecsencrencennsancsesssessancsesssnssasssnsssnssasssnssanes 50
TUTORIAL 5: IMASKING LAYERS ceuceeceectecrecsecsessesasasacsacsscsaccscssessessessessessessessessassases 71
TUTORIAL 6: IMAGE EVALUATION cucereererenecrensenecsensesensesscsessesessessesessesasessesassessssesces 91
TUTORIAL 7: COLOR THEORY tuceuceeceecrecsecsecsensesesensecsecssesscsscssessessessessessessessessesses 106
TUTORIAL 8: ADJUSTING TONES & COLORS secrersecsecsecsacsscsscsscsscssessessessessessessessassesses 114
TUTORIAL 9: TOUCHING UP PHOTOGRAPHS. cectetteetecsecsecsecsecsecsncssessecsessessessessessesseses 135
TuToRIAL 10: ADJUSTING TONE, COLOR, & FOCUS cerurrurrecracraccnccaensensensensessessessensanses 146
TUTORIAL 17: COLOR & SHADES OF GRAY .eeurerreerecsenrecsecsecseecsecsecsecsessessessessessesseses 165
TUTORIAL 122 CASE STUDIES cuceueeeesseecsesssenseccsesssessescsessssssesssessssssessssssssssnssssssassses 185
TUTORIAL 13: FILLS, VECTORS, & SHAPES ceecrerrererereiecrncseccaccnecnecsecsessecsessessensenses 193
TUTORIAL T4: FILTERS eeucencencencencenceectectecteccensesesensecsessessessascasssnssssescsnssnssesesses 223
TUTORIAL 15: WEB GRAPHICS ceuceereecrecsecsecsensessesensecsscsscsscssessessessessessessessessessesses 241
TuTORIAL 16: ARCHIVAL & PRINT FILE FORMATS ceutterraciaccncsaccacnsensensensensessessessessasses 254
TUuTORIAL 17: ACTIONS & BATCH PROCESSING ..euutecreerenrecreeseccnecnecnecsensensecsensensensannes 267
5 = U 277

Table of Contents Page iii



PracTticaL PHoTOsHOP CC 2015, LEVEL 2

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo



PracTticaL PHoTOsHOP CC 2015, LEVEL 2

TABLE OF CONTENTS

TUTORIAL 1: OVERVIEW & GUIDELINES..."‘...O....."‘...O....."‘...O....."‘...O....."‘...O.....'.‘...O. 1

(@] oY1=t 4 V7O USRS 1
GTEING STAITEA ettt sttt et s bt b et et e et e s e s b e e ebesesbe st sse s esessesasbenassenessenessensons 1
Using These Tutorials With PhOTOSROP ...ttt sse e s ss e ssens 2
The PhotOShOP APPIICATION w.ueceeeeceeeeeeeeee ettt ettt et et e b e s e s essensesaeseesaesessessansessensn 2
Hardware and SOftWware REQUITEMENTS.........ociiieeeiceeeeseeeete ettt e s e st e s be s ebessesessens 3
Adobe Creative CloUd REQUITEMENTS .....cccveieiciiicesieeseee ettt ettt saebe s e s e bese st e e e sassaneeseseens 4
Setting up your Monitor fOr PhOtOSNOP ..ottt et 4
Adobe Photoshop CC 2015 INSTAlAtion ....cceeeeieeiiiiiceiceeceeeseresetse et be e et a et besnsse e ens 5
A FEW TIPS BEFOIE YOU BEGIN ..ttt ettt ettt et et sesa e s esasaneesesans 5
ACtivation & DEaCTIVATION ...ttt et 5
Checking for FrE@ UPates ...ttt ettt sttt ettt st s ase st sns 5
AODE ID .ttt ettt ettt ettt ek a et bbbtttk et b e ae et b e et et be et et sene 6
Uninstalling Adobe PhotoShop CC 2075 iiiirienieririeiserisesseesseesseessesessessesessesessesessesessessesessssessesessenes 6
The Photoshop Native File FOrMat, PSD.....iiicecencriseestessseesssessesestesessessssessssessesessesessessssessssessesessenes 6
Guided Exercise 1.1: EXamMiNe @ PSD Fil@ ...ttt sttt 6
GENEIIC FIlE FOIMALS .ttt ettt ettt sttt et b ettt b e sttt e b e et b ebenenes 8
The JPEG (Joint Photographic Experts Group) File FOrmat.......ccoceoeevreinieeerirnseeieteeeeseeeeeeseeeenes 8
JPEG PrOPEITIES ettt ettt sttt et st et e st e b e st e sae st e be s st e besaaesbe s st e sesstenaesntenseeseensesnsensannns 8
SAVE AS VS, EXPOIT ettt ettt et e st et e st et et et et esa e s e ese e s e e s e ebaebe s s et anbantantantantensansentenseseesassaesessanes 9
Guided Exercise 1.2: Use the Save As Command to Save @ JPEG File......cccoovreinnineiennnicnneecce, 9
The EXPOrt AS COMMANG ..oouiiiiieiicirietretsertste st et e sseeste e sessesassesessesessesessaseesassssansssessasessessesassesensesansesessen 10
Guided Exercise 1.3: Use the Export As Command to Save @ JPEG File ..o, 10
The Adobe PhotoShOop SETHINGS FilE ...ttt ss et s e sse e sbesesbassssassssassssasses 11
To Restore the Default Adobe Photoshop Settings File: ... 12
How Does Photoshop Tell You When It is Out of WOrking Space? ... eeens 12
CustomMizZiNng PhOtOSNOP Pref@r@NCES. ...ttt sttt st s s s s e sasesesenas 13
IMAGE INTEIPOIALION .ttt ettt ettt ettt be e se st sbe e et esesenesesennnnas 13
PerfOrMAaNCE PrefEr@NCOS ..o ittt ettt sttt et ettt be e 14
IMEIMOTY USQQ ittt ettt et ste st s b st e s b st et et e st et et e st e st esaesassassassassasbassesbensensansensensensensones 14
HiSTOTY STatS ittt sttt ettt ettt et e st saessa s b e sbesbesbesbessanbensensenseneanean 15

Table of Contents Page v



SCIATCN DISKS Praf@IENCES ottt ettt ettt et sat st e sae st esaessbesaessbesstesbessessbessssssesssonsesssensesssonsesssons 15

(0L =1 e I 21U 1 F=T SRS 15
(10T (o U TG @ 1.V o RO 15
R B S OUICES .ttt ettt ettt ceb e e bt e e s b ees st e e eeab e e saasessbaeeeassesenssseestsesasseesasseeennsesenssseenbseessbaeesrsseesanseeensreeen 16

TUTORIAL 2: LIBRARIES & CAMERA RAW.cceeeeereereercenceescescencensenscessescessenscessescessenscesces 17

OVEIVIBW ..ttt ettt ettt ettt sttt et et b et e b et e bt e st e st e b et e b et e b et e b et e st et eae b enteb et e b et es et e e sbentesentesentene 17
(0] oY =Tt 4 V7O O TR EO TSRO TORRSRTRSRRRRRON 17
i DTS ettt ettt e b ekt b bt bbbt b et et e ae et e heae et et ebe ittt 17
CAMEIA RAW ..ttt ettt ettt ettt e e b et e bt e b et e st e b et ebe e se e ene 17
LIDIAIES ettt ettt ettt ettt b bbb bt e b bt b b st e b bttt b ettt b ettt e sttt sene 18
Guided Exercise 2.1: WOrk With LIDIaries ........cccceeereerireennieirtneeeeniseeieestseeieeseseesesest st esesesee s s sessesenenes 18
ADODE SEOCK cuueuieieiiiirteietrtre ettt bbb bbb bbb e s s e neaeae 21
THE RAW FOIMIAT ettt ettt ettt ettt ettt sttt b b et s e b e et ssesenenes 21
Advantages of the RAW FOIMAL ...ttt ettt ettt e et e n s nnne 21
Disadvantages of the RAW FOIMat.....cciiiiececc et s et a st asa s e s s ns 22
Adobe’s Digital Negative SpecificCation (DNG) ......cccceeeieeeerereriniiieerie et e e re s resse e sesessesessesassasesseseens 22
The Camera RAW PlUG-iN ettt te ettt e st e e b e a et e aebe st esa st asaebeneesessebassesastasassansssanens 23
OpPeN @ File iN CaAmMEIa RAW ..cciieiierieiriiieenieesteesteesiessesessesessesessesassessesessesassesessessssasessessesessesessesessesessessesensens 23
Camera Raw Dialog BOX LANAMArKS .....ccccivieirerirenirieniiinieenieesseessesessesseessesessessssessssessssensesessesassessssessssensens 24
IMAGE PrEVIEW ettt ettt ettt b e s bbb et e e et et et et enteneesesnessessessassas 24

The Camera RaW TOOIS PANEl. ..o ettt ettt ettt st 24
Z00M AN HANA TOOIS ..ttt ettt ettt ettt sttt be bt 24

The White BalanCe TOO ... ettt ettt ettt sttt et 25

The Crop and Straighten TOOIS ...ttt s b s s senes 25

Spot Removal and Red Eye REMOVAl TOOIS ..ottt 25

The Histogram and the Adjustments PAn€l.......ciiivieiniisceneercsecrsesseesseesseessesesesseesseessesessenens 25
The Adjustments Pane: BasiC Tab ..ttt ss et e ssesessessssassesassesassesessasens 26
The AULO & Default BUTTONS. ...ttt sene 26

WHTTE BAlANCE .ttt ettt ettt bbb et st et st e se et et ebanennnas 26
TeMPErature @aNd TiNt.. ettt e s s e e s e s et e et e e ssesesbesasbeseesassesassesasasessanens 27

TONAI AQJUSTMENTS .ttt s b b e e st e e et e et e e ssesasbasessansssensesensesasesessanees 27

COlON AJUSTMENTS .ttt ettt et s e st e sesese e et esesensesesanensesssans 27
Ot Er TADS ettt ettt sttt b et b et h et et b et b et et b et et senenes 28
RESET e IMAGE ettt ettt ettt e b e s e et e s e e be e ese st ese st ase st esaesanessassasesanes 28

Table of Contents Page vi



Recognizing an AdJUStEd IMAGE ...ttt ese e e s see e ss s e basasbe e sbasaesassesansesesas 28

Guided Exercise 2.2: Manipulate an Image in Camera RaW .......coevevevecineninininenineneeesseesieessessssesessenes 29
The AdJuStMeENt BruSH TOO! ...ttt ettt ettt e e et e s beaesassanesan 30
IMage AdJUSTMENT WOTKIIOW ..oviuiiciiciecsccetse ettt b et e e e ba st ssa s e e nan 31
Guided Exercise 2.3: Use the Adjustment Brush TOOI.......cccoiviinieinireniincninnerseseseneeseesse s esessenns 31
Guided Exercise 2.4: Process Your Camera RaW IMage T.....ocvviveinierinenineninininenteeseeesseesseessessssesessenes 32
FINTSNING U ctiiieeceeeeee ettt ettt e b ettt e et e s et ene et esaebessebestasa s eseebensebensesensasantanesan 33
Guided Exercise 2.5: Process Your Camera RaW IMaAge 2.....cciiveenienieneeseneesseesseessesesseessessssessssenns 33
CAMEIA RAW @5 @ FIlEOT cuniieiete ettt ettt sttt ettt bbb e s et ebenan 34
ON YOUT OWN .ttt ettt ettt ettt ettt et b et e b et e bt e bt e s et et b eat e b e st e b et e s et e ae b eneebentsbentebentesentenenes 35
RESOUICES .ttt b e bbb b ettt e et e et et e st e st e bt s Rt s b e e b e s b e b e s b e b e b e be b e b enaententeneenean 35

TUTORIAL 3: A FIRST LOOK AT IMIASKS eeeececccecceccecceccceccescessescccscescessesscsscsscessescesccssces 30

OVEIVIBW ..ttt ettt ettt ettt ettt et b et e b et e bt e bt e st et b et s b et e b et e se e e st b e st s enesb et eb et eseneenenes 36
(@ o [Tt {17 OO OO OO 37
NaVIGATION SHOITCULS .oviuieiiicctecceeesces ettt ettt e st et e e et e e e b et e s e teseebaseebeseesessesansesansasesn 37
Review the Layers PAnel BUTTONS ...ttt ettt sttt sttt et 37
QUICK MASK IMOTE ..ttt ettt sttt sttt et ettt b et st s et st ese s et bese st b esesene et eseneneatesenan 38
Standard Mode vs. QUICK Mask MOE ...ttt ettt sttt et 38
QUICK IMASK TIPS cueetiiteetesrietestestestestestestetertesteseesesseesessassessessassassassassessassassessansessessessassesaesassessansansansensansensensensansases 39
Guided Exercise 3.1: Make and Refine @ QUICK MasK......c.cceeeiiiiieninenininiineeeseseriesesesese st 39
LYo = T = 1 Y= K3 OSSR 42
To save a Selection as an AlPha ChanNel ...ttt nan 42
Guided Exercise 3.2: Save an AlPha Channel ...t sa e ans 43

To Load an Alpha Channel @s @ SEIECTION ...ttt b et a e ass e enas 43
LAYEE IMLASKS ettt ettt ettt ettt st b bttt b e bbb e bbb bea et e b e n ettt ae et bebe et ene 44
LAY EF IMASK BASITS.cuiiuiriiirieiriinieiinieinieestestsieststest et seste e se e sbesesbessesessesassesassesessessssensesensesessessssensesensesensesensenesses 44
Guided Exercise 3.3: Use the Refine Edge Command to Make a Layer with a Layer Mask.................. 44
Guided Exercise 3.4: Use the Properties Panel to Finish YOur IMage ......ccvevevevevccenecnceseseeeeenenns 45
Channels, Masks, and DOCUMENT SIZE.....ccvuruiirririeiririeieerteeee ettt ettt ettt sttt e e 47
Layer Math for the Completed GIass CIirCle ...t esenas 47

Use Layer Masks Like AIPha Channels ...ttt ettt sas s e essesenas 47

Delete Unnecessary Layers and Alpha Channels as YOU WOrK ......ccoocovreennnnennnecncnneeeneeines 48
Feathering Masks and SeleCtion EAGES ......civiivieiniiveniinciserisesteesseesree e e s e s e sse e ssesessasessassssessesesas 48

Table of Contents Page vii



(10T (o TUT @ 1.V o IR 49

(LT YU T Ll SRR 49

TUTORIAL 4: TYPE & SMART OBJECTS cecereeccccsecscessessessesscescessessessessoessessessessosssessessess D0

OVEIVIBW ..ttt ettt ettt ettt sttt a et et e ettt a et b et e b et e b e b e st b et ne st senterennene 50
TYPE TOOIS @NA TYPE LAYEIS ...ttt ettt sttt et e sa s et st sbe e sse st e et esassesessensesansesensesesenessenees 50
Editing TEXE iN TYPE LAYETS wecueruiiriiiriiieenieesietsiest st et e sse e sse st sbe st sse st ssessesassesestesassessssassssensesessenessensosensesensesesenes 51
SEIECEING TEXL ittt ettt ettt sttt s et s e st e b e s e e e et esesant st esaneatesesanensesesanenssssenenes 51
Text Selection, Editing, and FOrmatting TiPs....coeciiiiiiincierecnesseieese et e e s e ssenees 51

Point Text and Paragraph TeXt REVISITEA ....ccciviirirenieinirersertsesteesee et sse st saeve e e sssessenes 52
TransfOrMING TYPE LAYEIS oottt teseses st et sa e as e st e e et esesasessesesasessesesanensssesasenssesans 52
RASTEIIZING TYPE LAYEIS ettt ettt ettt st st b e bbb e st et e e et et et e st s st esessessesneses 52

TO rAStErIZE @ TYPE JAYET .ttt ettt ettt bbbttt et sane 53
Guided Exercise 4.1: Use the Horizontal TYPE TOO! ...t essesessesesseene 53
Guided Exercise 4.2: Use the Vertical TYPe TOO ...ttt ssesasseeene 56
Guided Exercise 4.3: Use the Horizontal Type Mask TOOI ......ccccuveirnrinininenininirnneeeeeceeeeeeiesesenenenene 57
Guided Exercise 4.4: Use the Vertical Type Mask TOOI ......ccoeueiririeieiinininieenreeetrieeetet et 58
Paragraphl TEX T ettt ettt et ettt et e e e b et e s et ese et ese et e s e e bensebantese et eseebene et enaebentereteretanes 59
Guided Exercise 4.5: Use Paragraph TEXT.. v ericreniirininieesieeseesesseesssessesessesessessesessesessesessesessessesensens 59

A Further Look at FOrmMatting TEXt.. ettt ettt e st e e b e e se st s s ese st e e sesassesassennene 60
The TYPE TOOIS OPLIONS BT wiiviiiriiiriitririeirieisieresesteesesess et st esse e ssesessesssbassesassesassesassasessassssensesensesassassssanens 60
The Character PAn@l ... ettt ettt ettt ettt s st sens 61
The Paragraph PAn@l ...ttt ettt ettt et se et ens et e e e b e b esestesasaneesanens 63
FINAING the RIGIT FONt...ecuiiicee ettt sttt st b e et s e a e st e se et et sans 64
SIMATT OB JECES ittt ettt sttt et e s e s et et eses e s e et et esers et esenars et esenereesesenersesesanersasas 65
Guided Exercise 4.6: Convert a Type Layer to a Smart Object and Apply Smart Filters........cceeuueee. 65
PIACING FIlES ettt e ettt ettt r et e s e b et eba b eseebese et essebensebessasesese et eneetensesensasersesersanes 67
Place EMBDEAAEA ...ttt ettt ettt ettt ettt et sbebe et et be et enas 67
PIACE LINKEA ..ttt ettt ettt st sttt b et b b et s b e s ae e st ebe et ebebenetnas 68
Guided Exercise 4.7: The Power of SMart ODJECS ..ot ss s 68

ON YOUF OWN ettt ettt ettt ettt sttt et s et et et a et e st b et s b et e b e e e se b e e senteseneereneene 69
RESOUICES ..ttt ettt ettt b et sttt s a et bt b et e bt et e st b et e b et se st e ne e st nens 70

TUTORIAL 5: IMASKING LAYERS ceeeceececscccsssccccsscccsssccsssscossssccsssscssssscssssssssssscssssccsssscce 7 1

(@ LYY VA =3RRI 71

Table of Contents Page viii



Create and Manipulate LaYer IMASKS .....ccceirerreriiineinieesiesesestssessesesseessesessesessessssessesessesessesessessssessssassesessesenns 71

Adding @ Layer Mask 10 @ LAY @r ..ttt ettt e st e st st esssse st s e sse e ssesassenassessssassssenes 71
Masks anNd the Properties PAN@l ...ttt ettt a e se ettt ae b e e s e s e s ennanean 72
Guided Exercise 5.1: Combine Two Images With Masking ......c.ccccceeeveereninenennenenenenirenriseseseeeeseseeeeeeeenens 73
APPIYING FIlters tO LAYEr MASKS.....cueueieirieeeiiieieiecietse ettt ettt et e ae st e et st ssesesesesesassesssanessssesensnsesenes 77
QUICK FITEEI REVIBW ...ttt ettt ettt st sttt ettt et st e s et st e sene b esesenessens 77
THE FIIEEI IMBNU ..ttt ettt ettt b ettt b et sttt et ene et ebenen 78

FIltEr GAllEry OVEIVIEW ..cviuiviiiirieirietretsetetste st ste s e st se st e e sse e sse e s b e s sba st e assesassesessassssensssansesensesess 78
Guided Exercise 5.2: Make a Type Layer with a Filtered Pixel MasK.......cccocoveeirreerennrenenneeereeeeeeens 79
USING Gradients @S LAYEr IMASKS .....ccueiviirierireririininenieesieestetstestste st e e sse e ssesassessssessesessesassesessessssensesensesessenesen 80
Partly Guided Exercise 5.3: Gradient Layer Masks........cccveerinireennineeerisiecestse e et esessesesnens 80
LAYEE IMASK TIPS cuteeueeirieieiirtrteieietet ettt ettt ettt sttt ettt b et st b e et st e b st e b st et e b e et et sbe et st ebesenttebeneneas 81
USING FIlEErs 0N LAYEr IMASKS .....uuieiiieiiiiec ettt ettt ettt ettt ettt e 82
Guided Exercise 5.4: Filter a Layer Mask to Provide an Irregular EAQe .....cccocevvevvvevvceneneeneneseeenenn 83
Layer Mask Cas@ STUY .ocuccuveriiirieiriiinieinietsierieesteeste e sesessessere st e et e e ssesassesasbessssessesessesasessssensesensesensesessenssses 84
ClHIPPING IMASKS .ottt sttt s b e e s b et e b e e e ba s e s et e e s b esesbesesbansesansesessesessasessensssansssansesenes 84
Layer Masks VS. CHPPING MASKS ....c.ciieirieiririreeeirteieceetseetseeteeesssseeesse e e ssesesaassssesasessssssasessesssenessssssnnns 85
Guided Exercise 5.5: Clipping Mask EXperimentation ......ccccceeveveneeeecenenisenseseeesees e sseesesenns 85
Guided Exercise 5.6: Make a Collage of Layers Inside a Clipping MasK.......cccovevrverrninenirinesinenieneennenens 87
Using YOUr Filled TYP@ DOCUMENT ..c.cviiriiririeirieenieestetsietstens et e ssesessesessessssassesessssassesassessssassesansesesesesss 89

ON YOUT QW ettt ettt ettt sttt ettt st b et b et et e b et s b et e b et se e e se b e st b ene s b et be st eseneenenes 90
Make and Filter a Heart-Shaped PiXel IMASK ......cceeireeeiieeeeesetetee ettt se st este st sae s seaennens 20
Experiment With YOUr OWN IMAQES ...ttt te et e et se s et e b esa b e s be s ba s esassenesan 90
RESOUICES .ttt sttt b e s bbb et et et et et et e e e st e at e st e st s ae s b e e b e s b e b e be b e s e se b enteneenteneenteneen 920

TUTORIAL 6: IMAGE EVALUATION 0000000000000000000000000000000000000000000000000000000000000000000000000000 91

OVEIVIBW ..ttt ettt ettt sttt et sttt ettt b et bt e b et e b et e s et et b e ae e b et e b et e s et e st st e st b ent s b et ebenteseneenenes 91
(@ o [Tt {17 OO USROS 91
IMAGE EVAIUATION ettt ettt ettt et e e st e s e et e s e et e s s e b et esa st enesaseebessesansesansesensanesn 91
Evaluation via the Histogram Pan@l ...ttt sse e sesessesessesaesassssessesesses 91
Guided Exercise 6.1: Use the Histogram Panel .........cveveriiniiniiineeneenetnesssessseseeesseessesessesessessssenes 92
Guided Exercise 6.2: ANalyZing HiStOGIams .......cceeueueeeiiiiieeiieecceeeeeeeeeseseeses e esesasesssas e sssssesesesenene 93
Guided Exercise 6.3: Modify an Image and Observe How its Histogram Changes .......c.ccccccvvueuenenee. 94
Identifying Problems in Overall IMage CONtIast......cccceveeeeerinieceereeeerteteeest et e s senens 96

Guided Exercise 6.4:

Table of Contents Page ix



Use the Histogram Panel to Evaluate Image CONtrast ...reenereniiniinsesesnseseeesseessessssesesessesessenes 96

COlOT CRANNEIS .ttt sttt b e et b et s b st b b et et e b e et saeneneaes 97
Differentiating Layers from Channels can be Very Confusing ........cccceveevennieenennnecenneecreseeeenes 97
Guided Exercise 6.5: Examine Color Channels ...ttt ettt 98
EVaAlUATING IMAGE COlOT ettt e ettt et et e e et e e e ba st e sastasesbenessansesansesansanansan 100
COIOT LSttt ettt ettt ettt sttt b et b bbb sttt beae At e b e s et et e bbb eb s ettt ene et et enen 100
Guided Exercise 6.6 Use the Color Sliders in the Color Panel to Mix Neutral & Non-Neutral Colors100
TRE INTO PANEI ittt ettt sttt ettt e et st e e e e e b eseseatesesanessesasenens 101
The Color SAMPIET TOO! ...ttt e s et et e e st e et e e b asaesansesessesessesassanansans 102
Guided Exercise 6.7: Use the Info Panel with Color SamPIers.......ceeveeeecneecereeceeee e 102
OO SAMIPIEE TIPS cutiiiitieiesieieietetete e te et eee e s e s te st et et et e st e b e s essensessessesaeseesaasasseesaesessansansansansansansensansensanaans 104
Guided Exercise 6.8: Evaluate an Image for Both Tone & Color.......ccvivnenenennnnrirerrreeeeeeeennene 105

ON YOUF OWN ettt ettt ettt sttt ettt a et a et s se st e be e b et e senesenentenes 105
RESOUICES ..ttt sttt a ettt e ettt a et bt b e e n e nenenen 105

TUTORIAL 7: COLOR THEORY ceeeeccceccecceccescescenscescescescesscsscescessessesscessessessesscsscescesce | 00

OVEIVIBW ..ttt ettt ettt et b et bt e b et e s et e st s b e a s b et e b et b et e se b e bt et e s et e st et et ebenteb et eb et esentenensentnen 106
(@ o 1T 417 TP TSROSO 106
Vision, Color Wheels and Primary COIOrS ..ottt ettt ss st st e et st e e s s sesassens 106
VErY BasiC COlOr TREOIY ...oiiiiieieeereece ettt ettt ettt st st b s se e s s e et et esesans st eseneasesesenersens 107
THE COlON WREEN ..ttt ettt ettt et ettt ettt et e b et ebesenens 107
The “Art” COlOr WHEEI ...ttt ettt sttt sttt sttt b et nen 107

The “ScienCe” COlOr WHEEI ...ttt ettt ettt 107

COLON MOAEIS ..ttt ettt st et b e st et e e st st esesane et esesenssesenenensssenen 107
RGB COlOT MOAEN .ttt ettt ettt et sttt ettt e bebe et et e st ebenan 108
CMYK COlOT MO ...ttt ettt ettt sttt ettt st b et b et st ebene et ebenen 108
COlOT GAMULS .ttt ettt ettt ettt sttt b sttt b ettt e b et ebe s et st s b e sttt sbeneasessenen 108
OUL OF GAMUL ettt ettt sttt st st e et e s e s e et e b ese et esenanesesesanersens 109
Web-Safe and Non Web-Safe ColOrs. ...ttt ettt 109
PhOtOShOP IMAGE MOES ...ttt sttt ettt e e e ba b e et ase st ene st anaesansesansanentan 109
Relating Image Modes t0 COlOr ChaNNEIS ...ttt a e sse e nas 110
Single Color Channel IMage MOES ...ttt e sse s ba s s e sesassesasses 110

Three Color Channel IMage MO ...t e e e esesssees 110

Four Color Channel IMage MOAE ...ttt se st e et se st e be s e bensesasenesan 110

HOW COlOr ChanNEls WOTK ....ucueeeieieeeiieieiecieteiectste ettt sttt ettt st s et st sse et be e et besesasesesenessens 110

Table of Contents Page x



Bt DEPTN et b e et e e bR b et e e e R e e e R et e s e et eRe et enaebaneesaneerens 111

The Purpose of EACh IMage MOAE ...ttt ettt s et sasessesasanens 112
RGB COlOF ettt ettt sttt et ettt et t b et ese st et e b e s et et ebene st et esesent st esanartesesanensesesanen 112

LA COl0T ettt et ettt b ettt b et et be et et b ettt be s 112

CIMY K COl0T ittt ettt ettt ettt ettt ettt b ettt b et st bttt e bt esebe et et ebe et ssene 112
GIAYSCAIE ettt sttt sttt s bbbt e b et e R et e R A e b et e b e e e R et e R e s e s et e e se e seneetn 112
BiEMIAD ettt et e e s h e b e e et e e et e et e b e et ebe et enbaeaesreenraaes 113

IMAGE MOAE CONVEISION ..ttt sttt ettt bbb bbb bbb st e ettt sttt ettt b et e s b bebesebesenenene 113
RESOUICES ..ttt ettt b et bt st se et et b et et e s a et se e ne e neas 113

TUTORIAL 8: ADJUSTING TONES & COLORS seeeceeesscesscesscesscessoessscnssonssoessoessosssoessecssee 114

OVEIVIBW ..ttt ettt ettt b et bt b et s et et et e st e b et e b et e b et e se b e st et e ae e b e ae et et e b et ese b e st s ene b eneesentesentnen 114
(@ o [Tt {177 OO OO STROSTRRR 114
Adjustment Layers and the Adjustments Panel ...ttt 114
The Adjustments Panel ICONS & BULLONS.......ccvciiieriericenceneteesseesteesse st ste e e e sesse e sesessesesseseesesassens 115
Guided Exercise 8.1: Use the Levels AdjustmMent LAYEr ....civivirenineneineeneeseseseseeesseesseessesessesssnes 116
Using Levels to Adjust Individual Color Channels ... 118
Guided Exercise 8.2: Improve an Image by Adjusting Individual Color Channels..........ccccoceeeniennee. 118
The Set POINT EYEQUIOPPEIS .ottt sttt sttt sttt e st e s et st esese st et esanensesesenensssns 120
Guided Exercise 8.3: Use the Set POint EyedropPers......cco ettt ettt eeeaeaes 120
Guided Exercise 8.4: Use the Set Point
Eyedroppers t0 NeULIaliZe @ COlOr CaSt.....iiiisisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssns 121
Guided Exercise 8.5: Use Levels to Adjust a Washed Out IMage ......ccceecveveneninenenenneneenieeneeesienennes 124
The Shadows/Highlights Adjustment COmMMaNd ..ot saesessesassessesens 125
Guided Exercise 8.6: Use the Shadows/Highlights Command to Lighten Shadow Detail ................ 125
THe CUIVES AQJUSTIMENT ....vieiiiecceeee ettt ettt ettt b e e et e sesesessesasenansesenenssesanensnsns 127
Guided Exercise 8.7: Use Curve Presets to Improve Image Contrast ......cccvveveeeveneneeneesereseressennenns 128
Guided Exercise 8.8: Adjust the Black Point and White Point Sliders to Improve Contrast................. 129
Layer Masks and ImMage AdJUSTMENT ...ttt ettt sttt ettt st 130
Guided Exercise 8.9: Use a Masked Adjustment to Brighten a FIOWeT ......cccovvvevvenvineinierenieenienenns 130
Guided Exercise 8.10:
Further Layer Mask EXPerimentation ... iciiniennenineeestsesteesseessessssessssessssessesessesessessssessssessesens 132
More on Adjustments and SMArt FIILEIS ...ttt be e nn 133
ON YOUE QWD ettt ettt sttt et et e et sae e e s b s be s b e sbe b e b et e s et et et eneentent e st e st eseesessesessessesbessensenseneenean 134
RESOUICES ..ttt ettt et a et b et st ae et et eb et e a et a et ne e s e eneas 134

Table of Contents Page xi



PracTticaL PHoTOsHOP CC 2015, LEVEL 2

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo



TUTORIAL 9: TOUCHING UP PHOTOGRAPHS cceeseeesscessoesscessssssosssosssosssosssssssssssssssssssse 13D

OVEIVIEW ..ttt ettt ettt sttt et b et b et b e e st e st et e b e st e b et e b et e se b e s et e s et e st b enteb et ebe st eb et esesenesentsen 135
O CEIVES ottt ettt ettt b etk e et s e R et e ke R Atk ese et ek ese et esene et esenenees 135
The Clone StampP TOOI REVISITEA ...ccuviiiieieeireieeerieee ettt ettt s s e st st sesasesns 135
Guided Exercise 9.1:
UsSe the Clone STamMP TOO ..ottt ettt ettt ettt b ettt bean 137
THE TOUCKH-UP TOOIS .ttt be et st s b e et e e e b et e s et e s et esa st esasbaneesansesessasesesassanassansasens 138
The HEaling Brush TOO ...ttt ettt be e e st s s e st e e ba e s e sesessesessesassasassans 138
Guided Exercise 9.2: Use the Healing Brush TOOI ......cccuveveiniininineinccenecnieesieesiesesesesvesseeseeesseenes 139
Guided Exercise 9.3: Use the Healing Brush Tool to Remove or Diminish Wrinkles and Blemishes 140
The SPot HEaling Brush TOO! ...ttt te ettt et s b se st e bennesans 140
Guided Exercise 9.4: Compare the Healing Brush Tool with the Spot Healing Brush and Clone Stamp
OO0 ettt ettt et h et h et e b bt et b ettt bbbt bese et b e be et et be et et enenens 141
ThE PAtCh TOO ...ttt ettt ettt ettt ettt ettt et e b se et ebenenens 143
COMIPOSITE LAYEIS..cueiiiieieieietetetete ettt sttt e s et e st e s b et et et e et et e e s st s aesses bt saesbesbessassessessensensentenseneentns 143
TO Make @ COMPOSIE LAYEI ..ottt ettt et sttt et b e et e s se et eseseneeesenan 143
Guided Exercise 9.5: Use the PatCh TOO ...ttt ettt 143
TOUCKN-UD TOO! TIPS uiiuiiieiitieieiectestetetetet et et et e e e se e e s e be st e st e b e se s e s essensessessessessessesassessasesessensansensensensensansan 144
ON YOUF OWN ettt ettt ettt e et a ettt ettt s b et b et s st e st e e s et b et be e e b et eb et esensenesentrnen 145
RESOUICES ..ttt ettt ettt sttt et b et e b et bt b et et et b ene s b et eb et e se e ene e entnen 145

TuToRIAL 10: ADJUSTING TONE, COLOR, & FOCUS ceereerreereescescescenseescescessensenscescescesse 146

OVEIVIBW ..ttt ettt ettt ettt a et bbbt ettt sa et a et a et se st ebe st e s et esesnenesentenen 146
O @ CEIVES ettt b et b e e b et e e e bRt b e b e Rt e R e R et e R e b e e e R et e b et e b et e se s esasenetes 146
THE TONING TOOIS vttt sttt et sbe st ste e st e e s be e sbesessessebesesessesassesessensssensesersesensenassensesens 146
DOAGING AN BUIMNING c.cviiiiiicicieicccieteteieeieiecieeee ettt ettt sttt b bbb bbb sesesenesesenenensacn 146
Guided Exercise 10.1: Use the Dodge and Burn Tools on a Grayscale Image........cccoeevevnrecerenennnne. 147
Guided Exercise 10.2: Use the Dodge and Burn Tools on a Color Image......cevvevvenneneeneeensenennas 148
DOAGE AN BUIN TiS.uiitiiriiriiiniiinieinietsiestsesteestesesseessesessessssessesessesassesessesessensesessesessessssessssensesensesessesessesseses 149
THE SPONGE TOO ettt s ettt et etenes 149
Semi-Guided Exercise 10.3: Use the Sponge Tool to Whiten Teeth .......cccevveveveverecenccncneeceesieenae 150
CONEENT-AWAIE Fill ettt ettt et sttt ettt e et ebese st st esesenassesanenees 150
Guided Exercise 10.4: Compare the Content-Aware Fill Command with the Patch Tool................... 151
EVAIUGTION ottt ettt ettt ettt b et bbbt et et ebebe et ne 153

DiIGITAl NOISE.uiuiuiiiiieiiiieertetre ettt ettt et et e st e sb e e s b e e et et e b e s esa s esessesesbassesansesansesassasessensssansesansesensaseses 153

Table of Contents Page xii



The REAUCE NOISE FIlEOI aevieeieeieeeieeieeeeeteeete ettt ettt s e et e st e ssae e st e sbessneessessessnsesnessssessseesssessssesssesnnes 153

Guided Exercise 10.5: Use the Reduce NOiSe Filter.....cccovrieererricinineerieeeeeneeeeerereee e 154
Sharpening @Nd BlIUITING ..ttt st sttt st s b e s be e sbe e ssessesessesassenasesassensrsn 155
The Focus Tools: Sharpen, BIUr, and SMUAGE.. ..ottt sre e ssssessesessesessesassessssessesens 156

Guided Exercise 10.6: Use the Sharpen TOO! .......ciiecieeieiseteee ettt be e nn 156

Guided Exercise 10.7: Use the BIUIr TOO ..ottt ettt sttt en 157

Guided Exercise 10.8: Use the SmMUAGE TOO! .....ccciviiirieireirineriseseeseese e se s st essesessaseeses 157

FOCUS TOOI WOTKFIOW ..ttt ettt sttt bbb aen 158
THE SNAIPEN FIlIS .ottt t e s bt st e e et et s se st e s e et e s e st esesbasessessesessesesasessesessanessansesens 158

The SMArt SNATPEN FIILEE ottt ettt et et s e e seereeseesessesbe s essesensensennan 158

The Smart Sharpen DIialog BOX. ... iiiciieeiceseeseeste et e e te e se s sesae e sesessesessesassensesensasens 158

Guided Exercise 10.9: Use the Smart Sharpen Filter to Improve Image FOCUS .....ccveveenevenrerenrennns 160

The GaUSSIAN BIUF FIlTEI ..ottt ettt sttt sttt ettt st be et 161

Guided Exercise 10.10: Use the Gaussian Blur Filter Selectively ... 161

THE Add NOISE FIIEOT c.eeieee ettt sttt ettt sttt be et ese et stesanenees 161

Guided Exercise 10.11: Add Noise to @ BIUITed IMage.....ccvciririeereereeseeseeseseseesseressesesseesseesseness 162
EAITiNG WITH HISTOIY ettt ettt sttt st ettt ettt b bt st eae 162

The History Brush TOOI REVISITEd.....c.cciiiiiiiiiiieesteesteenetsee et e te e e s e sse e ssesesbesassasessesnesens 162

Guided Exercise 10.12: Use the History Brush Tool to Selectively Paint Back in a History State.....162

Guided Exercise 10.13: Use a Layer Mask to Selectively Paint Back in HiStory .......ccoceeveeecuceennee 163
ON YOUF OWN ettt sttt sttt a et a et bt b et be b e se st s e a e s et et sne st enentenes 164

Play With TO-€lEPNant g . ettt ettt sttt ettt st se e 164

Find images that need repairing and fiX theM ...t 164

Lab Color Image Mode Trick: Sharpening @an IMage.....ciiieireieneineineeneseseseeesseesseessesessessssassesens 164
RESOUICES ..ttt ettt ettt ettt et b et s bt be e se e e st eat b et e s et se e eneeeneas 164

TUTORIAL 17: COLOR & SHADES OF GRAY eeeeereeccecccescescescecssesscessessessessonscessessessesscese 10D

OVEBIVIBW ..ttt ettt ettt ettt et et s st s ae e s e b e s b e s be s b e s b e b e b et et et et eneenteateat e st eaeese s s e ssebesbesbebebensensensenean 165
(@] oY T=Tat 4 V7P ST RSP TT O TETOTS TR 165
Converting from RGB tO GraySCale .....cuiriiiciieieceeseecireeetete ettt ettt s e ses et sasasessssasasessssannnnes 166
Guided Exercise 11.1: Explore RGB to Grayscale Conversion Techniques .......cccoececeevrecenneeceneneennes 166
The Black & WHite AdJUSTMENT ...cvouiiieiiiieiececeeteeerte ettt aes 170
Guided Exercise 11.2: Use the Black & White Adjustment ........cccveveveeeiniieneisereseeeee e 170
Black & White Adjustment SUGQEStioNS aNd ISSUES .....ccciviririririeenieeneeneeseseseeeesseesseessesessassssessesens 171
Partly Desaturated IMAages ...ttt ettt ettt bttt sttt ettt be et st eae 172

Table of Contents Page xiii



Guided Exercise 11.3: Make a Partly Desaturated IMage ......cccevveverennineinieeneeseesesesvesseessesessesennes 172
Guided Exercise 11.4: Apply Layer Blending Modes to a Partly Desaturated Image........cccceeceruenene. 173
OULPUL @S @ CONLACT SNEET ettt ettt a e e s s e st e e be b e s b e be s e b et ensensensessensanean 173

Guided Exercise 11.5: Use Contact Sheet Il to Combine the Iris Images into a Single File for Printing
173

ColoriZiNg GraySCale IMAGES ....cccvieeieeeeeeete ettt ettt ettt e st s et s sesase st esssenasesesenensesenen 174
Guided Exercise 11.6: Convert from RGB to Grayscale and Back.......cccoeceevirueecinineinninieenenseecneeanes 174
Guided Exercise 11.7: Use Color, Gradient, and Pattern Fill Layers with Layer Blending Options ..177
Guided Exercise 11.8: Explore Additional Colorizing TEChNIQUES......ccveveirieinierenererneeeeeneeene 179
The Photo Filter AQJUSTMENT ...cc.iiiiireieetreccreesce ettt esse e e e e st e s s e e s b e e sbasesbassesessesassesassanasans 181
Guided Exercise 11.9: Experiment with the Photo Filter ... 181
The Match Color COMMANG ...ttt ettt sttt a et b ettt b se e aee 182
Guided Exercise 11.10: Match the Colors of a Group of IMages........cccccvveveverererenenererereresniresereeeeeeenee 182
The Color RePlacemMENT TOO! ..ottt et a et e e ettt e e b e e st e s e bensebe s ebesbesasbenassensesens 183
Guided Exercise 11.11: Use the Color Replacement TOO! ......ccoeieecieeceencereeeeeee et 183
ON YOUF OWN ittt ettt sttt et s a et bt st e st e st et s b et e b et e b et e se b e bt st e st st ese b et ebenteb et eb et esesenesentsen 184
RESOUICES ..ttt ettt sttt s b b s b s bt e b et et et et e st e st e atese e Rt s ae s b e s bt be b esbessensenseneenseneentns 184

TUTORIAL T2 CASE STUDIES eeeerceecscesscecssscnsscnssoessonssosssossssesssosssosssssssssssosssssnsocssse | OD

OVEIVIBW ..ttt ettt ettt ettt et b et st b et e st et e b et e b e a e b e e b et e se e e b et e st b e st b et ebenteb et eb et eseneenesentrnen 185
Case Study 12.1: Restore @ Color PROtOGraph ...ttt ettt sae e 185
Case Study 12.2: Combine Two Similar PRhotographs........ ettt 189
ON YOUF OWN ittt ettt ettt et b ettt b et et e et et e b et b et e se b e bt st e st et e st b et ebenteb et eb et esetenesentnen 192
RESOUICES ..ttt ettt ettt b e s bbb e bt et et et e e et eat e s e e Rt e se e b e s bt besbesbesse s eneensensententans 192

TUTORIAL 13: FILLS, VECTORS, & SHAPES cecceceeccercercercceccessesccrccssccscescesscsscescescescesse 193

OVEIVIBW ..ttt ettt ettt ettt ettt b et b et et e e b e e b et b et s s et e st e st b e st b et e b et e b et eb et esensenesentenen 193
(@] o [T {17 T OO O USROS SURRSRRRSRO 193
VECEONS VS, PIXEIS ettt ettt sttt ettt sttt b ettt b et et e et eb et b e b ese et ene 194
FIl@ FOIMQAt ISSUES ettt ettt ettt st b et sttt st bt st b ettt b et bbb et s b ene et sbenen 194
FITT LQYEIS cueteeeteietirieisteestees et stesterest e e se e sse e e se e ss e s esa s esa st esessasesbeseesessesassasassesessesessessesensesensesessesessensesensesensesensesesses 195
Guided Exercise 13.1: Create & Manipulate a Color Fill LaYer .......uevneineiinenineenennenneeneeeseenennes 195
Gradient anNd Pattern Fill LAYEIS .. iiierieereeniisiseesesessesesseessesessesessessesessesessesessesassessssessesansesensessssesssses 197
Paths @Nd SNAPE LAYEIS . iiiiiiiiirieirieesietsestsiestsesseesseesse e sseseesessesassesassesassesessessssessssansesessesessessesensesensesassesesses 197
Guided Exercise 13.2: Create & Manipulate @ Shape Layer ... errinninieeneeneesenesenseesseessesenees 198

Table of Contents Page xiv



Using Document Rulers, Grid @and GUIAES .....ccviviririeenieenietnetsinteesteesseesseessesssessssassssessesessesessessssessssessesens 200

TRE VIEW IMIEBNU ..ttt ettt ettt ettt b ettt sttt b e et a e b e et st eseneaens 200

E XA S et sttt e et ettt b e s b e be b e bebe b eeentent 200
MaACINTOSN USEIS AIRIT ...ttt ettt ettt sttt ettt et et eae 200

PIXEI G ettt ettt ettt sttt ettt b ettt b et st e bttt ebe et et ebenen 200

LAY EF EAGES ittt ettt sttt ettt ettt s b et b et e st e st st e st s b et et et sae st sse s ene et eseebenaebeneenentenens 201

Y=L LTt oY o T <o [ =Y 3OO USROS 201

The DocumeNnt Grid @Nd SNAP .ot e e ae e st e st e e stesassaseesassesessesessasassessesensasens 202
GUIES ettt ettt ettt sttt ettt e b bttt b et s e b st et e b eat b b e b e et e b e b e sttt e b et et e bene b s benn 202
Guided Exercise 13.3: Set Up a Document with the Grid and GUIdES......c.cceeveeeeeeceeeneeereeeeee 204
Ruler, Grid, and GUIAE PreferEnCeS ...ttt ettt st sttt e et senenees 206
SNAP REVISITEA ..ttt et ettt et e b et e se b e e st e se et eseebeseesessesestesestasasasessanessen 207
Guided Exercise 13.4: Use the Rectangle Tool to Create a Simple Shape Layer ......ccevveveneverennnas 207
SNAPE DIAWING TIPS cuiriiiiiirerteinieirieisretsresteesteteste e te e sse st sbe e sbe st sbestesestesessesessesessensssessssensesensesesesessensssensesen 209
Path OPEIAtIONS cueveeiieeeteeeee ettt ettt et e b e et e s et ese et ess et esaebe st ese st ese et esasesassensesansasens 209
GEOMETIY OPTIONS ettt sttt sttt et e e e e et et e st e st st ese s st e sesbe s b e sesbessessenseneeneen 210
The RECEANGIE TOO! ..ttt ettt bbb se s se e ne e e neaeaes 210
Guided Exercise 13.5: Experiment with the Rectangle TOO! ......ccoeeieeincenccseeseeee e 210
EItiNg @ VECTON ODJECT oottt ettt a ettt e st e et e s e be st ese st ese et eneetesaesensesensanens 211
Guided Exercise 13.6: Edit @ VECLOr ODJECT . ..coiiviiiieeecerercrseteetsese et ve e re st a st e sbe e nan 211
The Rounded RECtaNGIE TOO ...ttt e st ettt e e be e e et ese st asesbe e banassansesens 212
Guided Exercise 13.7: Experiment with the Rounded Rectangle TOO! ......cccvvveveverrenieeneenierenennnnas 213
Rounded Rectangle ChallENge ...ttt se st se s b e ssesassaseenens 215

THE EHIPSE TOO .ttt ettt ettt et et e e e e et e ebe e b e st e b e b e b e s assessensensessanseseesaeseeseesasessesassansansanes 216
Guided Exercise 13.8: Use the Ellipse Tool to Make a Vector Mask on a Pattern Fill Layer................ 216
THE POIYGON TOO! .ttt sttt st st sb et st s b e st e sb e asbe st esessenessesessesassenassensesens 218
Guided Exercise 13.9: Experiment with the Polygon TOON.......ccccoveiirieininieereceeeeeeeeeeeeenes 218
TRE LINE TOO ettt ettt sttt et b e s et e b e et et eses e st et esesentesesenensesesanenssns 219
CUSTOM SNAPE TOO ittt ettt et ettt e b e b e b ese et e se st eseebesaebensesessesesesetesansensesensesen 219
TO Ch00S€ @ CUSTOM SNAPE ittt ettt et e st a b et e et e et e sesbe e ebeseesesaesens 219
SNAPE LIDIATIES ittt ettt e et et e b e s e se b e s e s b e se et e Rt et e s e e b et e s et e s et eRa et eneebeneern 220
Placing Documents int0 PROTOSNOP .ottt ve sttt beassanenens 220
Semi-Guided Exercise 13.10: Make the Vector SAMPIEr ...t esse e sseseeees 220

Table of Contents Page xv



(O 10T (o U TR @ 1.V o [P RT 222

RS OUICES ettt ettt e et e e et eee bt e e e bt e e s b e e esasseeeabeesassteesabeeessbeeesssbeessssesenssesanssesssstsesssseessseessneestns 222

TUTORIAL T4: FILTERS teeeeccccccccccccccccssccssscnsccssscsssenssoessocsssesssessscssscsssessssesssessscssee 223

OVEIVIBW ..ttt ettt sttt s h et b et ettt a et b et e e s et e b et e b et e e snenenentnen 223
O @ CTIVES .ttt et sttt b et bbb e b e e Rtk e Rt e e b e e e be Rt e b e e e b et e s et e e seneeten 223
REVIEW FIlEEI BASITS .ttt ettt b ettt sttt e bt ebe et s ee 223
Guided Exercise 14.1: ApPlYing ArtistiC FIItEIS oottt as 225
Guided Exercise 14.2: Use Filters to Make Artwork from Scratch.......oocvveeennnecnnneccrecceee 228
THE FIIEEI GAIEIY ettt ettt et ettt et ettt b et et e et et e ae et esesenesns 229
The Filter Gallery Dialog BOX. .. iieieinicinieisesisesteeseeste s sesessesessessesessesessesassessssassesessesessesessessssessssens 230
PrEVIEW SETTINGS.ctiiiiiieietetctete ettt sttt et et ettt et et st ssessessessesbasbessesbesbessensensensenseneeneen 230
APPIYING MUIIPIE FIIEEIS oottt sttt ettt st et s et sesasessesenannns 231

FIIEEE GaAllEIY TIPS cueieeeieieirieeirte ettt ettt ettt sttt b et st e bt st ese sttt e b e st b esese et ebeneneasesean 231
Guided Exercise 14.3: Using the Filter Gallery ...ttt 232
Guided Exercise 14.4: More Filter Gallery EXperimentation .....ccccvevrveneinenineninenenennenneeneeessenennes 235
Guided Exercise 14.5: Combining Filter Layers and Blending Modes .........ccoceevveecnreenennsceenennnns 237

ON YOUF OWN ettt ettt ettt ettt sttt b ettt a et e b et s et e be st er et esesneneenentenen 240
RESOUICES ..ttt ettt ettt e s st s e e et e e s et b et e b et e s e e e aentnen 240

TUTORIAL 15: WEB GRAPHICS ceceeeeceeccesceccecscescescesscsscsscessessessesscessessessesscsssescessesse 241

OVEIVIEW ..ttt ettt ettt sttt et b et bt b et e b et et sbea et e st e b et e b et e se b e b et e st et e st b et ebent e b et eb et ese s enesentsen 241
(@] o 1T 4177 OO O PR SRREUURSTO 241
Proprietary and Generic File FOIMAtS ..ottt ettt sttt snns 242
Comparing the Most Common Web File FOrMAts ..ottt ss s senens 242
JPEG or Joint Photographic EXPerts GrOUP ....cceccceecieeriisieeseestetseieeste e ste e sesaeseseessesessessssesessessssens 242
GIF, or Graphics INterchange FOrMaAt ..ottt be e a b a e s e stenenan 243
PNG or Portable NetWOrk GraphiC ...ttt e et s e st b b e b ens e s enenis 243
INAEXEA COlOT MOttt sttt ettt ettt ettt b ettt s bt e b e b ettt e b e et b ebesenentne 244
Guided Exercise 15.1: Explore Indexed Color MOde ...ttt aennns 244
GIF Optimization fOr the WED ...ttt b et nn 246
Guided Exercise 15.2: Set Up Save for Web to Preview Web Graphics on a Web Page ........ccu...e. 246
Guided Exercise 15.3: GIF OPtimizZation ...ttt ssesessesessessesessesassesassesesses 247
Guided Exercise 15.4: Preview GIF Optimization in a Browser and FiX [t ......ccccooveeeeeneeeviececeieeeenns 249
Guided Exercise 15.5: GIF Optimization with a Drop Shadow ... 250

Table of Contents Page xvi



Guided Exercise 15.6: PNG-8 OPtimizZation ......ccccvevrerinenniinininieenieeseesiesessesessessssessesessesessessssessssesssses 252
ON YOUT QW ettt ettt ettt sttt e a et st b et b et e e e e st e st s b et e b et b et s se b e st s ese s eesentenentnen 253

T o U Ll YRR 253

TUTORIAL 16: ARCHIVAL & PRINT FILE FORMATS ceeeteeceescescessecscescescessessenscnssessessessense 234

OVEIVIEW ..ttt ettt ettt st ettt st b et et a et b et s b et b et b et s se st e s et ese s enenentenentnen 254
O @ CEIVES .ttt ettt st sttt et et e st e s b et e b et e b e e e R et e R bR s R e R e e b e e e b e e e R et e R e s e s et e e e senaeseneeten 254
LOSSIeSsS VS, LOSSY File COMPIESSION ..ivviuirieirieiriiiniinieenteesieeseesesseesessessesessesessesessessssassssessesessesessessssessssansesens 255
Comparing the Most Common Print File FOrMAtS .....ccveeveviririniinirieentsesieeseesiesesseseseeseesessesessesessesassesesses 256
JPEG or Joint Photographic EXPerts GrOUP ....ccveeeenierinieirieinetsenieesieesteessesessestssessesessesessessssessesessesens 256
PDF or Portable DOCUMENT FOrMAT ....c.cuiieiiieciieice ettt sttt sttt st se st nenees 256
TIFF or Tagged Image File Format 256
PO SO CITICS cutitiieirieirieeetee ettt ettt et e st e et ese et e s e et ese et e s e e ba st e b et e R et eRe et e Rt e be st e be st ere et eseebeneeteraebaneereterens 256
Guided Exercise 16.1: Save an Adobe Photoshop PDF Fil€......cirineiniineesetneneneneenseesseesseeens 257
Guided Exercise 16.2: Save A file as @ PDF/X-T@:2007 ....c.ccoeeeerereeererereneneresesenesesssessssssssssesssesesesesesesenens 260
Opening and Editing PDF Files in PROtOSNOP ...c.cuiiiieeieeeeece ettt saens 261
Guided Exercise 16.3: Open an AdODE PDF Fil@..... ettt e ettt et ssenenas 261
PDF TaKe-HOME IMESSAGE ...uiiiiiiiiririeienietsietsiestsesseessesessesessesessasaesassesassesessesessessesassesessesessesessassssessesessesassesens 262
TIFF or Tagged IMage File FOIMat.. ..ottt vesss e sse et et e et e e sesassessesessesessesassasassansesens 262
Guided Exercise 16.4: Save a Non-Layered or Flattened TIFF.......cccovvvineinininennenneneenseensenesneseenes 263
EPS Or ENCAPSUIAted POSTSCIIPT ittt ese s e sse e be e sa e ssassesessesessasassasessansosens 264
Guided Exercise 16.5: Save an EPS File in PROtOSNOP cuouiieiieeeeeeeeee ettt 264
TIFF VS, EPS VS, PDF ..ttt ettt ettt sttt sttt bbb bbb s e e e e e e aeasaeaes 265
RESOUICES ..ttt ettt sttt et b et a et se et et e st s et e se e senteseneeneas 266

TUTORIAL 17: ACTIONS & BATCH PROCESSING ceeceeeceescesceccenceescescescensenscescessessessccscese 207

OVEIVIBW ..ttt ettt ettt b et bbb s et et st et e b et e b et e b et e se e e ae b e st s b e st e b et e be st ese st es et ene b enessentesentenen 267
(0] oY =Tt 4 V7T OO SE T O PSP O TR RORRRAOSRRRP 267
THE ACHIONS PANEI ..ttt ettt sttt bbb bbb bbb s e se e eaeaeaes 268
Guided Exercise 17.1: Use the Vignette (selection) ACtION ...t 268
MAKE YOUT OWN ACLION 1.ttt ettt sttt ettt ettt et s b e st st e sene e esesenesesesanertesesenensssns 271
Guided Exercise 17.2: Make and Test an Action to Change Print Resolution ......ccccecevevevevenrevenennn, 271
Generalize the ACtioN Creation STEPS .t te s e e s e s e e s s essesassesessasassas 272
Saving and LOAdING ACTION SETS .ottt et s e st et e e be e s sa s e s e s e s et esassesassanesan 273
TO SAVE @N ACTION SOTi.cnie ettt ettt ettt se e aenens 273

Table of Contents Page xvii



B LT Ko Y-To I T T2 Yl 4 [0 T Y=L SRR 273

BaTC PrOCESSING cuiiiiiiiieieeretreteest sttt sttt e st e st et et e s e b e e e sa st esesbesesbeseebaseesansesessasessanessansesansesansasesan 274
Guided Exercise 17.3: Batch Process a Folder of IMages.....civeireeseeieseecree e seeeeaenas 274
General Steps to Batch Process a Group of Images with the Same Action:......ccoceeevreirnveccncnennne. 275

ON YOUE OWN ittt ettt sttt a et a ettt e se st e be e e b et esesnenenentnen 276

RESOUICES ..ttt ettt ettt sttt e ettt b et bt bt n et nenenen 276

INDEX ceeceeeceeccencencenccescescescenscnscescescenscnscnscessensenscescessessensenscessessensesscessessesscnsces 27 7

Table of Contents Page xviii



PracTticaL PHoTOsHOP CC 2015, LEVEL 2

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo



PracTticaL PHoTOsHOP CC 2015, LEVEL 2
TuToRIAL 1: OVERVIEW & GUIDELINES

Adobe Photoshop® is the industry standard software for image editing. Practical Photoshop CC 2015, Level 2
is the second book in a series to guide you through the intricacies of digital image creation and editing. In this
book you will develop more layer and adjustment skills, differentiate between pixel and vector based image
components, and work with layers, channels, and especially masks to build complex Photoshop documents.

You will need Photoshop CC 2015 for either Mac or Windows to complete the majority of the tutorials in this
book. No support will be given for earlier software versions or for the Photoshop Elements application. All
screen captures in this book were taken using Photoshop CC 2015.1.1

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

OBJECTIVES

= Download the example and tutorial files for the book.

= Examine the hardware and software requirements for Photoshop CC 2015 and set up your computer
system accordingly.

»  Work with PSD and JPEG files.
- Differentiate between PROPRIETARY and GENERIC or UNIVERSAL file formats.
«  Describe the strengths and limitations of both the PSD and the JPEG file format.
+  Use the Export As command with various settings to duplicate PSD files as Web-optimized JPEG files.

= Customize the most common Photoshop preferences:
Image Interpolation, File Handling, and Type.

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

GETTING STARTED

At the beginning of each tutorial you will find an Objectives section so you know what you will accomplish by
completing the tutorial. All the example and tutorial files used in this book can be downloaded at: http://
www.practical-photoshop.com/pages/CC-2014-level2.html.

When expanded (unzipped), you will have a folder named PP2-images. Inside the folder ’J PPZ-images
1
are individual folders for each tutorial in the book.

At the end of each tutorial you will find an On Your Own section where you can continue your study of
Photoshop, or further develop skills or concepts introduced in the tutorial itself. There are also additional
resources as appropriate.
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Graphics or computer terminology known as KEY TERMS are set off in bolded all caps when they are defined.

Computer menu commands and keystrokes are set off in boldface as are panels, bars, buttons, and other
workspace elements.

....................................................................................

UsING THESE TUTORIALS WITH PHOTOSHOP

Photoshop menu commands often involve drilling down from a main menu to one or more submenus. We have
used a greater than sign (>) to show you the sequence to follow. For example, Image > Adjustments > Black &
White directs you to first click the Image menu, then the Adjustments submenu, and finally the Black & White
command to turn a color photo into a black and white (grayscale) photo.

All Windows computers and modern Macintosh computers (except older laptops) use computer mice or track
pads with (at least) two mouse buttons.

If your mouse has two or more buttons:
» Click means to press and release the left mouse button.

= Right-click means to press and release the right mouse button.
If your computer only has a one button mouse or a single trackpad button, you will need to CONTROL-
CLICK: press and hold the control key and then click the single button to simulate a right-click.

= Drag means to press the (left) mouse button and keep it down as you move the mouse.
= Press means to press one of the keys on the keyboard.

Photoshop often uses MODIFIER KEYS on the computer keyboard along with mouse clicks to extend the
capabilities of those keys.

Windows typically uses the ctrl, alt, and/or shift keys.
Macintosh typically uses the command ((ﬁ or 38 ), option, control, and/or shift keys.

The plus sign (+) indicates when a modifier key is required. For example, you might alt + click (Win) or
option + click (Mac) to perform a particular function.

When you use modifier keys, you are supposed to press the key(s) and click the mouse at the same time. Timing
can be tricky. You may find it easier to first press the modifier key(s), then click or drag the mouse, and finally
release the mouse button before releasing the modifier key(s).

....................................................................................

THE PHOTOSHOP APPLICATION

Adobe produces two image-editing applications: ADOBE PHOTOSHOP ELEMENTS’ and the full ADOBE
PHOTOSHOP’. Photoshop Elements is a less expensive, consumer level graphics-editing application.
Elements is terrific for simple image editing, but does not have nearly the range of capabilities as the full
Photoshop application. Elements offers a good training ground for moving into the professional application, as
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both applications use similar working environments and approaches to image production and editing. We do not
cover Photoshop Elements in these tutorials.

Adobe first acquired Photoshop in 1990. Since that time, there have been several improvements, or
UPGRADES. The most current version of Photoshop is Photoshop CC 2015.1.1, released in November 2015.

You can obtain your Adobe software by monthly or annual subscription to the Adobe Creative Cloud. Here are
the specifics: https://creative.adobe.com/plans?plan=edu.

ooooooooooooooooooooooooooooooo

HARDWARE AND SOFTWARE REQUIREMENTS

Photoshop works equally well with either Macintosh or Windows computer systems. Image editing requires lots
of processing power, and Photoshop works much more swiftly on newer, faster computers. Before purchasing
Photoshop, make sure that your computer hardware and software are adequate. To use Photoshop effectively,
you will need a fast computer, a modern operating system, and enough RAM and hard disk space to manipulate
your images as you edit and save them. And, of course, you will need the Photoshop application itself. Let's look at
each of these minimum requirements (more is better) in more detail.

1. Afast, powerful computer with a current operating system:
Macintosh
Multicore Intel processor with 64-bit support (no Power PCs)
Mac OS X v10.9 or higher

2 GB of available hard-disk space for installation; additional free space required during installation (cannot install
on a volume that uses a case-sensitive file system or on removable flash storage devices)

Windows
Intel® Core 2° or AMD Athlon® 64 processor (2GHz or faster)

2 GB of available hard-disk space for installation; additional free space required during installation (cannot
install on removable flash storage devices)

Microsoft® Windows 7 with Service Pack 1 or higher

2. Enough RAM (random access memory) and hard disk space to manipulate your images as you edit and save
them.

2GB of RAM is what Adobe says. In our experience, 4 GB of RAM should be the minimum, and 8 is better.
3. Additional requirements:

1024x768 display (1280x800 recommended) with OpenGL 2.0, 16-bit color, and 512MB of VRAM (video
random access memory)

This software will not operate without activation. Broadband Internet connection and registration are
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required for software activation, validation of subscriptions, and access to online services. Phone activation
is not available.

© e 0000000000000 0000000000 0 0 00

ApoBE CREATIVE CLouD REQUIREMENTS

If you are installing additional Creative Cloud applications, not just Photoshop and Bridge, the hardware
requirements are somewhat greater. For either platform, you will need at least 3 GB of RAM (8 desired) and
more than 7 GB of free, contiguous hard disk space.

SETTING UP YOUR MONITOR FOR PHOTOSHOP

Computer monitors display patterns of colored square dots called PIXELS. Because those pixels are very small,
we don't see them individually, but instead see the bigger “picture”

MONITOR RESOLUTION measures how many pixels fill the screen horizontally and vertically. 640 x 480
means that the monitor shows a grid of 640 pixels across and 480 pixels down. When you increase the
monitor resolution, everything on the screen becomes smaller so you can fit more things on it. Photoshop uses
many items to help you edit images, and you will need to set your monitor resolution to at least 1024 x 768
pixels to see and use all those items.

COLOR DEPTH sets how many different colors your monitor can display. For most Photoshop images, your
monitor should be set to millions of colors (also known as 24-bit color) so that color images look like true
photographs on your screen. Here is how to check your monitor resolution and change it if needed:

Wi ndows Display Properties {E”X‘

Themes | Desktop | Screen Saver || Appearance | Settings

1. Close or minimize any open applications so that you can see your computer
desktop.

2. Right-click a blank area on the desktop to reveal its context menu.

3. Choose Properties from that context menu to view the Display S
Default Moritor on Parallels Yideo Driver

Properties dialog box.

Screen resolution Color quality

Less 737 More Highest (32 bif] v
4. Click the Settings tab and check your resolution and color settings. Color 1024 by 768 el —_—

quality should be Highest (32 Bit), and Screen resolution should be
1024 x 768 pixels or higher. =

5. Click OK if settings were changed, otherwise click Close. X T— -
9 ged, “ W aAe 3@
Macintosh S oo )

1. Choose Apple ( o> System Preferences.

2. Inthe Hardware group, click Displays.

3. Check your resolution and color settings, and change if necessary.

Resolutions:

720 x 480
800 x 600

896 x 600

640 x 480 (stretched) r | Colors: | Millions ts |

800 x 600 (s

Refresh Rate: n/a

tretched)

Detect Displays

1024 x 768

1152 x 768
1280 x 854

1024 x 768 (stretched) ™ Show displays in menu bar

one of these

% Number of recent modes: [ 3 (=)
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Set Colors to Millions, and Resolution to 1024 x 768 pixels or higher (1280 x 800 is recommended).

4. Choose System Preferences > Quit System Preferences.

@ e 0 0000000000000 0 000 e e 0 o © © 0 0 0 0 00000 0000000000000 0000000000000 0000000000000 000000 0 O

ADOBE PHOTOSHOP CC 2015 INSTALLATION

Whether you install just Photoshop CC 2015 and Bridge CC, or additional Creative Cloud applications, you will
need to download the software from the Adobe Web site and follow the on-screen prompts to install the software.

Photoshop CC 2015 for Macintosh is a 64-bit only application. In Windows there are two versions, 32-bit and
64-bit. When you install Photoshop CC 2015 for Windows, the installer will choose the appropriate version for
your particular operating system. The 64-bit version will run more quickly and use as much RAM as allotted to
it. The 32-bit version can only use 3.2 GB of RAM.

@00 0000000000000 000000 00

A Few Tips BEFore You BEGIN

= If you are upgrading from a previous version of Photoshop, keep your serial number handy as you may
need it to complete the software installation.

= No Adobe applications or Web browsers should be open on your computer as you install.

= If desired, uninstall and remove earlier versions of Photoshop and Bridge before you install CC 2015. You do
not have to remove older versions, however. You can run Photoshop CC 2015 on the same computer as earlier
versions of Photoshop, Bridge, or Elements.

@0 0000000000000 000 0 00

AcTivATION & DEACTIVATION

Single-user licenses of Photoshop CC 2015 require that you activate the software online before using it for
more than 30 days after its first use. According to Adobe, this is a “simple, anonymous process.” A single-user
license allows you to place Photoshop CC 2015 onto two computers —such as work and home, or a desktop
and a laptop—with the assumption that you will use Photoshop on only one machine at a time. If you want to
install the software on an additional computer, you must first deactivate it on one of the original computers.

e e 0000000000000 000 00 00

CHECKING FOR FREe UPDATES
| Helo | ~ 0 @
The Creative Cloud applications are quite complicated, and although Search |
Adobe works hard to make them perfect, problems sometimes arise. What's New...
Photoshop Online Help...
When Adobe fixes these problems, or adds features that were not iR RS s R e
included in the shipped software, UPDATES become available for ECf Uit
. . Manage Extensions...
download and installation. Browse Add-Ons...
. o System Info...
1. Open any of the Creative Cloud applications. ystem o
Manage My Account...
2. Choose Help > Updates to go online to the Adobe Updater to Sign Out (LAIRD@DONALDLAIRD.COM)
X X Updates...
check your computer and see if any updates are available.
Photoshop Online...
Photoshop Resources Online...
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3. If any updates are available, you will be instructed to download and install them.
You probably will not be able to update software if you are working in a computer lab or network.

e e o0 e 000

Apose ID

An Adobe ID, plus your password, gives you access to special membership benefits on Adobe.com. It is
required to complete your software installation and essential for viewing special training and help features for
Creative Cloud applications.

© 0 0060000000000 000000000000000c0 000

UNINSTALLING ADOBE PHoTosHor CC 2015

When you install your software, uninstallers are placed in your system. In Windows, the Add or Remove
Programs control panel should allow you to uninstall Photoshop or other Creative Suite applications. On the Mac,
by default, the uninstallers are placed inside the Applications > Utilities > Adobe Installers folder.

© © © 0 0 0 0 00000000 00000000 0000000000 000000000000 00000000 0000000000000 0000000000000 00 00 O

THE PHoTOsHOP NATIVE FiLe FormaT, PSD

As you work in Photoshop, you typically use Photoshop’s NATIVE or PROPRIETARY file format, PSD. PSD files
are capable of using all of Photoshop’s tools and commands.

© e 0600000000000 000000000000000 00 e

GuiDeD Exercise 1.1: ExamINE A PSD FiLe

In this guided exercise you will examine a PSD document first in Adobe Bridge and then in Photoshop itself to
see some of the special Photoshop capabilities you will explore later in the course.

1. Place the PP2-images folder you downloaded onto the Desktop so that its location matches ours. (Place it
where you want once you complete this exercise.)

800

(=] Desktop - Adobe Bridge
> v @9 ¢ | @ E- B+~ essenmiac Workspacess ]

Favorites up 5 gmusers > @ barbiMac > = Desktop > B~ Menu
pe.Panel,

2. Open Adobe Bridge.

Sort by Type ~ A

-= [PREVIEW|

3. Choose Window > Workspaces ot i

Y FoLDers

— Computer

> Reset Standard Workspaces.

4. Choose the Essentials
workspace, click the Favorites
panel if it is not active, click
Desktop, and finally click
the PP2-images folder in the
Content panel.

5. Add the PP2-images folder to
the Favorites panel:

« InWindows, drag the icon of the PP2-images folder from the
Favorites panel where it says Drag Favorites Here.

E[i!ﬁ COLLECTIONS XPORT |—=

ﬂ barb_iMac
=

# Documents
£ Pictures

parallels share PP1-CSB

d folder

- L

EPSON Scan

PP2-CS6 PP2-images
Practical Photoshop
Level 2 student image

PP2-images
S IBRTAY KEvwoRrDs -=
File Type
Keywords
Date Created
Date Modified
Camera Raw

to file

8 My Computer
__J Adiiristrator

I My Documents

) My Pictures
Drag Favorites Here...
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+ Ineither Mac or Windows you can right-click the PP2-images folder in the Content panel and choose

Add to Favorites from the contextual menu that appears.

6. Clickthe PP2-images folder in the Favorites panel to reveal its contents in the
Content panel. Note the individual folders for each book tutorial.

7. Double-click tut-01 to view its contents and click 01-glass.psd to =

view its File Properties in the Metadata panel. You may need to
scroll down to see the File Properties.

Before using an image, it is helpful to check it in the File Properties [FfIRSURSETRET IR, | S,

Jpg Jpra

panel in Bridge to see its size and resolution. 01-glass.psd has print
dimensions of 5” x 8” and a resolution of 300 ppi, which means it
Filename 0l-glass.psd

should print well. But with pixel dimensions of 1500 x 2400 and a Document Type Photoshop document

Application Adobe Photoshop CS6 (Macintosh)
Date Created 1171211, 7:01:17 AM

or to include in a Web page. Date File Modified Today, 4:02:03 PM
File Size 17.93 ME

8. Open 01-glass.psd in Photoshop and examine some of the Dimensions 1500 x 2400

Dimensions (in inches) 5.0" x 8.0"

file size of 17.93 MB, this file is way too large to email to someone

special PSD features you will learn to use in this course: Resoluti _
esolution 300 ppi

a. Double-click the 01-glass.psd icon in the Content panel in
Bridge to open the image in Photoshop.

b. Either restore Photoshop’s default settings or reset its tools, colors, and the Essentials workspace.

¢. Examine the Layers panel. o & 3§ “ ohoto Fifter 1
01-glass.psd has two layers, the Background and a Photo Filter 1 o | aackground
=

adjustment layer.

The adjustment layer has a layer mask to hide the glass sculpture itself so that the warming Photo
Filter adjustment layer affects only other parts of the image.

d. Show and hide the Photo Filter 1 adjustment layer to see how it affects the image; it is a subtle
adjustment.

e. With the Background layer active, examine the Channels panel. Layers | Channels Paths

¢
© [§iRGB

The bottom of the Channels panel contains the glass sculpture alpha

channel, a stored selection that is saved with the document. Once <4 ,& Red
created, alpha channels can be used to quickly reselect areas of an image, [P H —

and can be terrific time savers. =
o ’,;b Blue
|

9. In the Status bar, look at the document size. Both Alpha
the layer mask and the alpha channel add to the
size of the layered document on the right compared with its FLATTENED or
unlayered size on the left.
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10. Leave 01-glass.psd open for the next guided exercise.

....................................................................................

GENERIC FILE FORMATS

GENERIC or UNIVERSAL file formats are not linked to specific software applications. These formats can be
written or used by many programs but typically do not have all the editing capabilities of proprietary format
files. For example, you cannot preserve separate layers in Photoshop files that are saved in JPEG or GIF format.

................................................

THe JPEG (JoINT PHOTOGRAPHIC EXPERTS GROUP) FILE FORMAT

JPEG, pronounced jay-peg, is a file format that was initially developed for printing photographic images. Used
now for both screen and print purposes, the JPEG format was originally developed before graphical Web
browsers were invented. JPEG’s initial purpose was to allow photographers and digital artists to make compact
files to transmit to their service bureaus for printing.

Many consumer-level digital cameras and nearly all camera phones save their pictures in JPEG format to write
the images more quickly and to make more images fit on memory cards.

The JPEG format has become the predominant Web format for displaying photographs and other continuous
tone images. Saving JPEGs for Web and email increases the file compression, making small files which are
appropriate for screen viewing but not for high quality printing because of JPEG ARTIFACTING, a pattern of
large, square blocks sprinkled through the picture, that can occur when the JPEG Quality is lowered to decrease

file size. This image, magnified to 400%, shows the difference between the top 100% a4 m
Quality, with minimal artifacts, and the bottom 0% Quality where gray squares are
sprinkled throughout the black type.

-- f

JPEG artifacting is CUMULATIVE meaning that the loss in image quality becomes < s 108001

more severe if you save and resave a JPEG image. For that reason, if you need to
make changes to your image after saving in JPEG format, you should edit the source a
PSD file and then resave the JPEG.

hEG
15

TIP: Use File > Save As to change JPEG images into PSD format to avoid
additional JPEG artifacting as you edit those images.

--------------

JPEG PROPERTIES

JPEG is an excellent file format for the Web because it permits 24-bit or 16.7+ million colors in images but still
produce files that are small enough to load quickly on Web pages. RGB and CMYK image modes are supported.
Not all of these JPEG properties are covered in this course but we are listing them here for completeness.

= JPEGs cannot have layers except for the Background layer.
= JPEGs cannot store alpha channels.

= JPEGs do not support transparency or animations.
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JPEGSs can contain embedded vector paths and can be used for color separations for CMYK printing.

JPEG is a LOSSY compression method, meaning that when you save in JPEG format, your image
permanently loses some data and its quality diminishes. The higher the JPEG compression, the smaller the
file size, but the worse the quality. The lower the compression, the larger the file size and better the quality.

For print, use maximum Quality (100%).

© © ¢ 0 00 0000000000000 00000000000000000000000000o0

SAVE As vs. EXPORT

oo

e 00 0000000000000 00

Within Photoshop there are two primary ways to convert file formats:

File > Save As lets you initially save a document, replace that document with new Save

settings, or save a copy of the document with a different file format. You use File > Save As

whenever you need to convert a file for printing or to be placed into a printed document,

such as an InDesign file.

You can also use File > Save As going the other direction, to save a JPEG original in PSD

format for Photoshop editing.

File > Export > Export As is specifically used to optimize the conversion of images
to generic formats for display on the Web or on handheld devices such as smart

phones.

.

e e e 00000000000

.

v Photoshop
Large Document Format
BMP
CompuServe GIF
Dicom
Photoshop EPS
IFF Format
JPEG
JPEG 2000
JPEG Stereo
Multi-Picture Format
PCX
Photoshop PDF
Photoshop Raw
Pixar
PNG
Portable Bit Map
Scitex CT
Targa
TIFF
Photoshop DCS 1.0

Photoshop DCS 2.0

The older Save for Web command is now found at File > Export > Save for Web (Legacy).

Let's compare these two file saving commands:

e e 0 00

© © ¢ 0 0000000000 00000000000000000000000000000 0

oo o

Guipep Exercise 1.2: Use THE SAvE As CommAND 10 SAVE A JPEG FiLE

In this guided exercise you will use File > Save As to make a JPEG copy of 01-glass.psd.

1.
2.

Begin with 01-glass.psd open in Photoshop.

Choose File > Save As and examine the Save settings. Since this 01-glass. Format:
psd contains both layers and an alpha channel, both of those are checked to G

be included in the Save As file.

Choose JPEG from the pop-up Format menu to change the file format from

the default Photoshop to JPEG and examine the Save
settings.

Notice that the Save settings are grayed out because those
settings are not available in the JPEG format.

The warning triangle exclamation points emphasize that

( Photoshop

[ As a Copy
EAlpha Channels

E Layers

Format: [ JPEG

Save: fAs a Copy __ | Notes
& _ | Alpha Channels _ | Spot Colors
M [ Layers

Color: __ Use Proof Setup: Working CMYK

[ 1Embed Color Profile: sRGB IEC61966-2.1

M File must be saved as a copy with this selection.
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Photoshop will make a copy of the original image, and that copy will lose the alpha channel and layers from

the original.
JPEG Options
4. Rename the file 01-glass-print.jpg and click Save to save the JPEG R
i Matte: | None = oK
copy in the tut01 folder. _
Image Options [ cancel |

5. When the JPEG Options dialog box appears, set the Quality to Quality: [W [ [ Medlum s | o o

Maximum (12) to minimize JPEG artifacting. . e | ek

@000 0000000000000 00

THEe ExporT As COMMAND

File > Export > Export As is designed to create smaller copies of big, complex images without diminishing the
quality of the original source file. This copy is known as an OPTIMIZED version of the file.

The Export As command is useful to:

= Optimize files for transmission via the Internet, for use on the Web, or to send through email.
= Strip unneeded file information to decrease overall file size.

» Temporarily adjust the pixel dimensions of an image without changing the original file.

= Compare the effects of file compression on image quality.

» Export multiple versions of the same file at once.

© © © 0 0 0 0 0000000000 00000000 0000000000000 0000000000000 0O0OC o

GuiDeD Exercise 1.3: Use THE ExporT As CommAND TO SAVE A JPEG FiLE

In this guided exercise you will use File > Export > Export As to optimize 01-glass.psd in JPEG format. In a
later tutorial you will save 01-glass.psd in other Web formats for comparison in appearance, transparency, and
file size.

1. Begin with 01-glass.psd open in Photoshop.
2. Choose File > Export > Export As. This will open a huge dialog box with your image in the center.
3. Identify the major regions of the Export As dialog box: v

a. The central pane of the dialog contains the image Thumbnail.

b. The File Settings section is used to choose the file format for
the exported image.

¢. The Image Size section lets you change the number of pixels in - > —a=mu
the exported image.

d. The Canvas Size section will not be addressed at this point in
the course.
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4. Change the file format of the exported image from PNG to JPG:
a. IntheFile Settings region change PNG to JPG.
b. Check the file size in the left-hand panel.

The JPEG is much smaller than the PNG. With the default quality of 100, the JPG file will be 1.5 MB,
instead of the 4.4 MB PNG.

5. Reduce the number of pixels in the exported image to reduce its file size:

a. Locate the Image Size section in the right side of the dialog box.

b. 01-glass.psd has a height of 2400 (pixels). That is way too large for Web Image Size

Width: 500|

viewing, especially on a laptop where the screen height is 900 pixels or less.
eight: 800
Change whichever dimension is larger, Height here, to 800 pixels and then HS g:ﬂ 55 50%
cale: 33.33%

press the Tab key to move the cursor to the next box.
Resample: Bicubic Sharper

When you type in the new height and press Tab, the Width recalculates to
keep the image proportional, and the preview changes on screen. Alternately, you can choose a Scale
percentage from the pop-up menu in the Image Size section.

The JPG file would now be 318.6 KB when saved. If you are required to keep the overall file size below a
certain point, lower the Quality setting in the File Settings area until the file size is at the desired value.
For example, if you need this image to be no larger than 200 KB, lowering the quality to 90% bring the
file size down to 195.1 KB.

6. Setthe Resample option Photoshop should use to change the Image Size to Bicubic Sharper.
7. Save the file:
a. Click Export All to save the copy of your image using your chosen settings.

In the Export dialog box that pops up next, notice that the image is already appended with .jpg, the
three character extension for JPEG files. Name the file 01-glass-small.jpg.

b. Click Export.

The web-sized copy, in JPEG format, will be saved to the place you designated with the original,
unchanged, document still open. Close the original if desired.

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

THE ADOBE PHOTOSHOP SETTINGS FILE

Application PREFERENCES are settings for window and panel locations, tools, dialog boxes, and color settings.
Each time a tool, panel, or command setting is changed, Photoshop saves the new configurations in the Adobe
Photoshop Settings File on the computer’s hard disk.
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Application DEFAULTS are the original settings created when the program was first installed. As you learn
Photoshop, you may want to restore these defaults each time you launch the program so that your working
environment is consistent, and it matches the environment described in these notes. Occasionally, the Adobe
Photoshop Settings File becomes corrupted, and Photoshop works very slowly or otherwise misbehaves.
Restoring the Adobe Photoshop Settings File can often solve these problems.

ooooooooooooooooooooooooooooooooooooooooooooo

To ResTore THE DerauLT ADOBE PHOTOSHOP SETTINGS FILE:

1. Check to be sure that Photoshop is not already open. Exit or quit the application if necessary.

If Photoshop is open, you will see its name on the Windows Taskbar, or its icon in the Mac OS X Dock with a
symbol underneath it.

2. Locate the Photoshop application icon in the Start menu (Windows) or the Applications folder (Mac) on
your hard drive.

3. Position your fingers just over the modifier keys, but do not press the keys. Capitalization matches the
keyboards.

1> shift

Windows : Ctrl+ Alt + Shift

Macintosh : command + option + shift
The Command key, lower right here, is the one with the Apple logo and the
cloverleaf.

The fn key shown here is only found on laptops and some Mac keyboards.

4. Start Photoshop and then immediately press the modifier keys and keep them Rdabe Protashs
pressed until you see this confirmation dialog box. If you don't see it, your Ps| et the debe Thoteshop Setthes 7
keystroke timing was off. Quit or Exit Photoshop and try again. o ves

5. Click Yes to delete the (old) Adobe Photoshop Settings File
and replace it with the default settings file.

6. If you see a dialog box asking to configure your color settings, click No to retain the current color settings. You
will not see the additional dialog box unless your color settings have been specified.

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

How Does PHoTosHOP TELL You WHEN IT1s OuT oF WORKING SPACE?

Not Enough Memory is an error message that says there is not enough memory to do something. This means
that the computer has run out of true RAM. So, what should you do? In this order:

1. Quit any open applications other than Photoshop.
2. Close any open Photoshop documents that you are not using.

3. Save your document (if you can).
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4. Clear your History from RAM by pressing the History panel popup menu and choosing Clear History. This
will clear the history for just the current document. If you need to clear the history from all open documents,
choose Edit > Purge > Histories. You cannot undo the Purge command but you can undo the Clear History
command.

5. Choose Edit > Purge > Clipboard to remove anything that is kept in the Clipboard’s RAM.
6. Reboot the computer. RAM fragments just like disks, and restarting the computer defragments the RAM.
7. Install more RAM.

Your Scratch Disk is Full really means that your hard disk, or combination of scratch disks, does not have
enough room for additional, virtual RAM. It is important not to use up most of your hard disk space for storing
your files. Back up to removable media on a regular basis and then delete files to free up space.

To avoid getting in to this mess again, back up and clean out your hard drive, or add an additional fast hard
drive to your system.

CustomizING PHOTOSHOP PREFERENCES

PREFERENCES are application settings that allow you to customize the appearance General... e
of your Photoshop application, and change the way some features work. They can :”\‘Iterkface---

orkspace...
be set under the Photoshop menu in Mac OS X or in the Edit menu in Windows, Tools...
organized by category. History Log...

File Handling...

Each preference setting has a tool tip to briefly explain its function. Each time you change Exp:rt---

errormance...
a tool, a panel, or a command setting, Photoshop saves the new configurations in its Scratch Disks...
Preferences file on the computer’s hard disk. All but the Plug-ins and Scratch Disk Cursors...

. . . . Transparency & Gamut...
settings and a few General settings such as Export Clipboard can be changed without Units & Rulers...
closing and reopening Photoshop. Guides, Grid & Slices...

Plug-Ins...
Photoshop Preferences are organized into the topical categories shown in the Type...
3D...

Preferences submenu. Technology Previews...

These preferences are important for the topics covered in this book: Camera Raw...

IMAGE INTERPOLATION

IMAGE INTERPOLATION, found in the General settings group, describes the method used when scaling, resizing,
rotating, or otherwise transforming images and selections. It is the method Photoshop uses to mathematically
determine how to fill in the “missing” pixels when upsampling, or precisely how to remove the excess pixels

when downsampling an image. Since interpolation can degrade image T ——

quality, it is important to pick the method that will do the best job. Bilinear
Bicubic (best for smooth gradients)
Of the six choices of interpolation, these four will give you the best results: Bicubic Smoother (best for enlargement)

Bicubic Sharper (best for reduction)
¥ Bicubic Automatic
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= Bicubic gives reasonably precise resampling, resulting in fairly smooth tonal gradations.
= Bicubic Smoother is designed for minimizing artifacts when UPSAMPLING (enlarging) images.

= Bicubic Sharper is used to minimize softening of images when DOWNSAMPLING. This is the interpolation
method used for almost all the screen images in these notes. Occasionally Bicubic Sharper will over-
sharpen image areas. If that happens, undo and use plain Bicubic instead.

= Bicubic Automatic will automatically choose between Bicubic Smoother or Bicubic Sharper, depending
on whether you are upsampling or downsampling.

FiLe HANDLING PREFERENCES

File Handling Preferences tell Photoshop how to save all or specific kinds of files. These preferences are
divided into two parts: File Saving Options and File Compatibility (Options).

File Saving Options let you include Image Preview data such as icons or Windows thumbnails when you save
your documents. It makes the files a little larger, but they are also faster to preview when opening an image. We
typically use the default settings.

Images are automatically saved (by default) in the background every 10 minutes. This can be very helpful if
Photoshop crashes while you are editing a large file (and forgot to save often).

Next are File Compatibility options. The important preference to change here is the bottom one, Maximize

PSD and PSB File Compatibility from Ask to Always. The native File Compatibility
Photoshop format, PSD, was limited to 30,000 by 30,000 pixels Camera Raw Preferences...

Prefer Adobe Camera Raw for Supported Raw Files

per image. Large document format, PSB, supports documents

Use Adobe Camera Raw to Convert Documents from 32 bit to 16/8 bit

up to 300,000 pixels in any dimension, and up to 6 GB in size. T eon
Originally designed for huge, high resolution printed documents, Ignore Rotation Metadata

Ask Before Saving Layered TIFF Files

like billboards, the PSB format is also used to edit layers that contain
Smart Object layers. You will use PSB documents later in the course. PERE ComprEanOTEE SRS

Maximize PSD and PSB File Compatibility lets you save .psd files

Maximize PSD and PSB File Compatibility: = Ask v

that can be opened in earlier versions of Photoshop as well as in .psb format.

e 0000000000000 0000 0 00

Memory Usage Graphics Processor Settings
PERFORMANCE PREFERENCES Available RAM: 13491 MB Detected Graphics Processor:
Performance Preferences can both \deal Range: 7420-9714 MB YD o ien GT 20N Oparb Erin
diagnose system hardware or setup e WL I e e

= N
issues, and let you tweak them. You may a Advanced Settings...
need to exit and reopen Photoshop for [EEEESEXEEE
Changes to take effect. Optimize Cache Levels and Tile History States: 50 v
Size for documents that are:
Tall and Thin Cache Levels: 4 7

Memory Usage Cache Tile Size:  1024K v

Default

Set Cache Levels to 2 or higher for

Memory usage examines how much Big and Flat ) ortmum G pertormance.
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random access memory (RAM) is theoretically available to Photoshop, specifies the ideal range for your

system, and then gives you a slider to adjust the RAM. The computer in the screen shot above has 16 GB of RAM
installed, but after system usage, only 13+ GB are available, and Photoshop uses 9 GB, leaving some RAM for other
programs. That is why Adobe recommends setting no more than 70% of your available RAM to Photoshop.

History States

By default, Photoshop saves 50 automatic History States in the History panel as you work on a document. If the
RAM in your system is marginal, and you work on documents bigger than, say 10 MB, you may want to lower the
number to 10 History States and see if performance improves.

@000 0000000000000 00 0 00

ScrATCH Disks PREFERENCES

If Photoshop runs out of RAM while processing a command, it can use free, contiguous hard disk space for
additional processing. This space is called a SCRATCH DISK.

If your computer system has more than one disk drive Scratch Disks

attached to it, additional drives can become extra scratch LET L Fiee Space Inforation
1 Macintosh HD 10.97GB Startup

disks. This system has one internal hard drive and one flash 2 Extra Storage 463.69V8

drive mounted. The flash drive is nearly full, so only the
internal drive (MacintoshHD) is assigned as a scratch disk (checked).

The Scratch Disk region can be used to diagnose another system problem. Photoshop requires 1-2 GB of free
disk space to install the software, but you realistically need at least 15-20 GB of free contiguous space, and more
if you edit files with lots of layers, like you will do for this course.

If you find Photoshop crashes a lot, you may need to clean off your hard disk, or add an additional one. Adobe
recommends that if your computer has more than one hard disk, you set your primary scratch disk to a drive other
than the one that contains the Photoshop application. (We have not done that here.)

e e 000000000000

UnNiTs AND RULERS

We will examine Units and Rulers preferences in the vector tutorial along with rulers, grids, and guides.
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ON Your OwN

The tut01 folder contains three related images that we developed for the exercises you will use in Tutorial 3.
01-orig-circle.jpg is the original file taken with a digital camera. In 01-circle-solid.jpg, the image was cropped
into a square and the area outside the glass circle was covered with a deep red color fill layer. In 01-circle.jpg the
opacity of the color fill layer was reduced from 100% to 88% to let some of the foliage outside the circle show
through. Experiment with Save for Web settings to make a Web-optimized version of each. Notice how the
square vs. rectangular file dimensions affects your optimization settings. Also notice that with the entire image
filled with detail, not solid color, the file sizes are quite a bit larger than the one with the solid background.
That'’s the nature of JPEG compression.
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RESOURCES

http://www.practical-photoshop.com/pages/CC-2015-level2-resources.html#01
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PracTticaL PHoTOsHOP CC 2015, LEVEL 2
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PracTticaL PHoTOsHOP CC 2015, LEVEL 2
TuToRIAL 2: LiBRARIES & CAMERA RAw

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

OVERVIEW

Knowing what to include in the first tutorial of an intermediate Photoshop book is a tough challenge. Photoshop
is such a huge application that it is very easy to forget basic skills. But this being Photoshop, we know you want to
do fun things right away. So, what we have decided to do here is to intersperse review with two new topics:

= How to use LIBRARIES to store commonly-used elements

= The RAW file format and the Camera Raw plug in

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooo

LIBRARIES

» Identify the image elements that can be stored in the Libraries panel.
« Colors
« Layer Styles
«  Text Styles
»  Textsnippets
«  Graphics
= Create, rename, and delete libraries.

= Locate Adobe Stock Images for your projects.

oooooooooo

CaMERA Raw

= Evaluate the pros and cons of the Raw format and DNG.
= |dentify the major sections of the Camera Raw dialog box.
= Improve image tonality and color with the Basic tab settings:

«  Observe how the Histogram, especially with Highlights and Shadows Clipping turned on, can help
diagnose problems with image tonality as you adjust an image.

«  Experiment with the White Balance settings in the Basic tab, including the Temperature and Tint
sliders.
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Selectively lighten and/or darken parts of images with the Exposure, Highlghts, Shadows, Whites,
and Blacks sliders.

Adjust image tonality with the Contrast slider.

Differentiate among the Clarity, Vibrance, and Saturation sliders, and observe the effects of each
slider.

Identify and use these tools in the Camera Raw Tools panel:

Zoom and Hand Tools
White Balance Tool
Crop and Straighten Tools

Adjustment Brush Tool

Explore the various ways to finish your adjustment: Save Image, Open Image, Cancel, or Done.

LIBRARIES

The Libraries panel allows you to store frequently-used image elements for easy retrieval. Moreover, you can

create as many different libraries as you want, so you can easily keep track of the elements unique to specific

projects, clients, or type of work. In addition, you can sync these libraries with the Creative Cloud app so that

you can log in to the cloud and access the libraries from anywhere.

GuIDED EXERcCISE 2.1: WORK WITH LIBRARIES

We are now going to create a new library and place a content into it.

1.
2.

Open the Photoshop application.

Set up your workspace so it is consistent with ours: ===
3D
We recommend you follow this procedure at the beginning of each new Guided Exercise ;""t‘_’““ B
jotion
sequence as you work through the tutorials. We will not repeat these instructions. Painting
Photography
a. Choose the Essentials workspace from the Workspace Switcher menu in the

upper right corner of the Options bar (if Essentials is not already chosen).

Design Space (Preview)

Then choose Reset Essentials from the Workspace Switcher menu. Reset Essentials
New Workspace...
To reset colors, locate the Color Controls towards the bottom of the Tools Delete Workspace...

panel and click the black and white boxes to reset your foreground and

Default - Swap

background colors to the default black and white. T
While you are here, review the other components of the Color Controls. DForeground
The upper left color swatch is the foreground color and the lower color Background
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swatch is the background color. The double arrow swaps the foreground and background colors.
e. Resetyourtools:

1) Activate the Zoom Tool. (You can do this with any tool, but the Zoom Tool is a good choice
because zooming does not change document contents.) :

Reset Tool

2) Inthe upper left corner of the Options bar, right-click the icon of the active Reset All Tools .

tool and choose Reset All Tools from the context menu that appears.
Locate and activate the Libraries panel. R, ustmants  Styles

By default, the Libraries panel should be visible after resetting the Essentials
workspace. It will be grouped with the Adjustments and Styles panels. If the
Libraries panel is not already visible, choose Window > Libraries to display
the panel. If you've not used Libraries before, you should see the No Libraries
Present message.

Create New Library

Click the “+Create New Library” button
and enter a name for the new library, then

+ Create New Library

[ Cancel

click the Create button.

Create a new document. Use the default Photoshop size preset.

Add color swatches to your library:

a. Choose a foreground color of your liking. *r 4

b. Click on the Add foreground color button at the bottom of the ——

My first library

Libraries panel. This adds your chosen color to the library and shows its color .

value (in hexadecimal notation).

Colors

#00FF12

¢. Add two more colors to the library. Notice that the new colors are added to —
olors

the top of the list of colors. You can not rearrange the colors - the newest is always at JOOFF12

I #CoEFAT
d. Ifyou add a color you don't want, highlight it in the Libraries panel and click on the B #rFrAFO3

the top.

Trash icon at the bottom-right of the Libraries panel. You may also drag the swatch to
the Trash icon. Please note that either way, you will not be warned that you
are deleting a saved swatch, and the action is not Undoable.

Add a layer style to your library:

a. Create a new layer. Use the Pencil tool to paint a large blob in the center of

the layer.

b. Use the fx button at the bottom of the Layers panel to add two or more
effects to the layer. Here, we added Bevel & Emboss and a Drop Shadow to an orange blob.

Tutorial 2: Libraries & Camera Raw Page 19



10.

Let’s say that this particular colorful blob is something that you might want to use

Click the fx button at the bottom of the Libraries panel. This adds the effects applied
to the current layer to the panel in the Layer Styles section. It is automatically given

the same name as the active layer.

Change the name of the style by double-clicking on it, like you would change the
name of a layer.

Replace the layer effects on the current layer with two others, then save the new
style in the Libraries panel. Here we added a gradient overlay. Notice that the
thumbnail in the Libraries panel shows a miniature version of the effects that
make up the style.

again. Time to add it to your library:

a.

Type can be added to the Libraries panel in two different sections:

a.

Apply your saved library items to a new document:

Click on the Add Graphic button on the bottom of the Libraries panel. You'll see that there’s now -
a new section in the panel for Graphics. In addition, see the small Ps
logo to the right of the name? This shows you that this graphic was } Layer 1

created in Photoshop. This matters because you can also add items
created in otehr Adobe CC applications to your library.

Double-click on the Ps logo. This opens the graphic in its own document window, where you can make
any desired changes to it. Once you save it, the library will be updated with the edits you made.

Create a type layer. Here we placed the word “Blob” right on top of the shape we
created earlier.

You can now choose what part of the type you want to add to the Libraries panel
— the formatting of the type layer, or the type layer itself. If you click on the

Character Styles
Add Character Style button on the Libraries panel, the formatting applied to m Myriad Pro Bold
the type layer (font, size, and color) will be saved as a Character Style. If you - St’”:y"’adp"”' ol S5t Fea
ayer Styles

click on the Add Graphic button, the whole type layer (with formatting intact) n oy
will be saved as a graphic object. Here you can see where we added it to the

Libraries panel in both sections. Do the same thing with your type layer.

Create a new document, or open an existing image.

Drag the blob graphic from your library into the document window. Notice that Photoshop
automatically creates a new layer to contain the blob shape.

Drag the type graphic into your document. You'll see it creates a type layer for you.

Click on one of the color swatches in the Libraries panel. The text will take on that color.
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e. Click on one of the Layer Styles to apply it to the type layer.

11. If you are logged into your Creative Cloud account, every item you add to the
Libraries panel is automatically synchronized to the Cloud. To see a Web page Aa .
that lists all of your library items, choose the View on Website command from
the Libraries panel pop-up menu. This will take you to the page where you can
see, rename, or delete your library items. You can also collaborate with others by

inviting them to have access to your library.

ee 000000000

ADOBE STOCK

The Libraries panel also allows you to search the Adobe Stock image collection Libraries

in order to find stock photos to use in your projects. To access Adobe Stock: My first library

= Type your search term(s) in the Search Adobe Stock area of the Libraries o)
panel. As you type, reults will appear below the search field.

= When you find an image you like, move your cursor over the image. You'll see [y

two icons appear - one to purchase the image, and the other to download a

Results from Adobe Stock
low-resolution watermarked preview version of the image. This preview, or
comp, image is usedful for determining if the image will work in your project.
The idea is that you can use comp images to design your project, then

purchase the final version when you are ready to publish the project.

= Once you've downloaded the preview image, it will be added to your active

#93338693

library. From there, you can place it into any image project. To purchase the
final non-watermarked version, right- Rt
click on the image in the library and

Buy Image...

choose Buy Image. This will take you
to the Adobe Stock Web site where
you can complete the purchase.
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THE RAw FORMAT

Professional and many consumer-level digital cameras allow you to save your images in RAW or unprocessed
format, to provide considerable control over how each image is processed, or to process the same image in
multiple ways for varying effects. Here is an excellent description from Adobe Evangelists Julianne Kost & Daniel
Brown. It was written quite a while ago, but the content is still current.
http://www.jkost.com/pdf/photoshop/cs2/AdobeCameraRaw.pdf

@000 0000000000000 00000 0 00

ADVANTAGES OF THE RAw FORMAT

= Far greater control of image processing than other formats such as TIFF or JPEG.
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= Raw files are typically smaller than uncompressed TIFFs.

= Raw files avoid the artifacts found in compressed JPEGs.

= Camera settings such as White Balance can be adjusted after the image is taken.

= Creation of high bit images, for greater detail and for more subtle editing and color correction.

= Restoration of overexposed areas of an image using Adobe’s Camera Raw.

DisADVANTAGES OF THE RAw FORMAT
= Raw images must be processed before they can be viewed or edited, adding an extra step to using these
images.

= Many cameras require that Raw images be shot at the camera’s maximum resolution, making larger
files than may be needed. And without JPEG compression, these files are really large. From a typical
16-megapixel camera, a Raw file takes 16 MB of storage, and a maximum-quality JPEG only 6 MB.

= Not only do the large Raw files gobble card space, but they also take longer to write to the camera card
which can cause a slight delay from one shot to another (on a slower camera).

= The Raw format is not standardized. Each camera maker has defined its own proprietary Raw format, and
sometimes there are even different formats between cameras made by the same manufacturer.

e e e 0000000 e e 00000 @00 0000000000000 0000 00 o o . © © 0 0600000000000 0000000000000000000 00 o

ADpoBE’s DiGITAL NEGATIVE SPECIFICATION (DNQG)
Without a standardized Raw format, you can have trouble converting images if you change cameras.

If you cannot open your camera’s Raw files into Photoshop, Adobe’s Digital Negative Converter or DNG will
let you convert those files to the DNG format, an open format for anyone to use.

You can read more about Camera Raw and download the converter for free from Adobe at: http://www.adobe.
com/products/photoshop/extend.html. Here is what Adobe lists as the key benefits of the DNG format for
photographers:

= The DNG format helps promote archival confidence, since digital imaging software solutions will be able to
open your Raw files more easily in the future.

= Asingle Raw processing solution enables a more efficient workflow when handling Raw files from multiple
camera models and manufacturers.

= A publicly documented and readily available specification can be easily adopted by camera manufacturers
and updated to accommodate future technological changes.
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....................................................................................

THE CAMERA RAw PLUG-IN

The Camera Raw plug-in that ships with Photoshop can be used non-destructively to edit not only Raw but also
JPEG and TIFF images, which greatly expands its versatility.

= When you open a Raw image in one of the Adobe applications, the Camera Raw Plug-in takes over, and
displays the Camera Raw dialog box so that you can control how the image should appear when it opens
in that application, such as in Photoshop.

= Theimage that opens is a duplicate, so that you can keep the original, or archival version, untouched.

= Adobe has been constantly updating the Camera Raw plug-in since its inception.

OrPEN A FiLe IN CAMERA Raw

If you double-click the thumbnail of a Raw image in Bridge, it automatically launches the Camera Raw plug-in
with its huge dialog box where you can manipulate the data that the camera captured along with its associated
metadata.

You can also open JPEG and TIFF files, the other common formats that digital cameras save in, with Camera
Raw. However, you cannot open PSD or PDF files in Camera Raw because Raw does not support layers.

JPEG and TIFF files open directly into Photoshop unless you “divert” them into Camera Raw first. You can use
Bridge to open JPEG and TIFF files.

= InBridge, highlight any JPEG preview in the Content pane, and then choose File > Open in Camera Raw.

If you want to open all your JPEG and/or TIFF images in Camera Raw first, you can do so by changing your
Camera Raw preferences in Bridge. You may want to do this temporarily when you have a lot of camera JPEGs
to import, and then change the preference back when you are done. We are also showing the process here in
case you don't want to routinely open all JPEGs and or TIFFs in Camera Raw, but Photoshop insists on doing it.

1. Launch Bridge, if it is not already open.
2. Choose one of the following to open Camera Raw Preferences:
Mac: Adobe Bridge CC > Camera Raw Preferences...
Windows: Edit > Camera Raw Preferences...
3. Locate the JPEG and TIFF Handling preferences at the bottom of the dialog box.

4. Change the preference to Automatically open all supported JPEGs.

If instead you want JPEGs and/or IPEC and TIFF Handling

TIFFs to Sklp the Camera Raw step, JPEC: [ Automaticallv open IPEGs with settinas }':j
Disable TIFF support

1il33 ¥ Automatically open TIFFs with settings
Automatically open all supported TIFFs

restore this setting to the default
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Automatically open JPEGs with settings. Now only JPEG or TIFF files that have already been processed in
Camera Raw will open directly into the Camera Raw dialog box.
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CamMERA Raw DiaLoGc Box LANDMARKS
Image Preview

When Camera Raw first opens, you may see a yellow exclamation symbol in the upper right corner of the
image preview. Because Raw files are so large, this caution symbol informs you that Camera Raw is still loading
the preview, and to wait until it goes away so that your preview will be accurate.

0.0.6 ‘Camera Raw 8.3~ JPEG

@ e e 0000000000000 00000 0 00

THe CAMERA RAaw TooLs PANEL

G |[# B et fa][ ] /[®]0]=]2]C] TOOLS

The Camera Raw Tools panel is at the top left corner of the

Camera Raw dialog box, above the image preview.

Tint

The Full Screen button to the right of the tools panel will ‘ <77 s e
expand the Camera Raw dialog box to cover the entire & '
screen, and give a bigger area for the image preview. The

actual size depends on your screen resolution.

Lets look at some of the other tools, from left to right. Here

Open Image Cancel | [ Done |

we will only describe what they do, but you will get to use I HANDIING

them shortly.

Zoom and Hand Tools olTh
S ok

The Zoom Tool and the Hand Tool work similarly to their Photoshop counterparts, and they use
the same keystrokes to increase their functionality:

= Activate the Zoom Tool and then click on the image preview to zoom in. Alt/Option + Click the Zoom
Tool to zoom out.

= Double click the Zoom Tool to view at 100%.
= Activate and drag the Hand Tool to pan the image preview within its pane.
= Double click the Hand Tool to Fit in View.

= When another tool is active, you can press the space bar and drag the preview to
temporarily use the Hand Tool.

You can also press and drag the Zoom Tool over a particular part of an image to
enlarge the region to fill the Image Preview pane.

Just below the left corner of the Image preview are more Zoom controls.

The center box displays the current zoom level, 33.3% here. The minus and plus =+ 33.3% 0%
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buttons zoom out or in set increments. Alternately, you can click in the zoom level box and choose your zoom
level from the Zoom menu.

The White Balance Tool

A COLOR CAST is a non-neutral tint of a particular color, usually unwanted, which affects an entire ﬁ;f
photographic image evenly.

WHITE BALANCE adjustments remove unrealistic color casts so that objects which appear white in nature are
rendered white in the photo.

The White Balance Tool lets you click on a neutral area (light, gray, or dark) in your image to set it as the
Custom white point. All the other colors in the image are then based on this value. The White Balance Tool
provides a precise way to eliminate the color cast in an image.

The Crop and Straighten Tools ﬁ, =0

When you choose the Straighten Tool and drag across an area of the image that should be a straight
horizontal or vertical line, the image will rotate to straighten when you release the mouse. Then the Crop
Tool will become active so that you can crop off any missing regions of the image. The Crop Tool works like in
Photoshop, but it does not actually trim off the cropped areas until the image is opened or saved.

Spot Removal and Red Eye Removal Tools =
< |

The Spot Removal Tool is kind of a blend between the Clone Stamp and Healing Brush tools
in Photoshop. Although originally designed specifically to remove dust specks that are found on many SLR
sensors, the Spot Removal Tool can be used to do other kinds of retouching, non-destructively of course. The
Red Eye Tool is similar to the Red Eye Tool in Photoshop, except that it is nondestructive.

© 0606000000000 00000000000000000000 0 00

THE HisTOGRAM AND THE ADJUSTMENTS PANEL

A HISTOGRAM is a graphical representation of the colors and tones in your
image. When you adjust an image, the graph changes. A color image, straight

from a digital camera, has its colors arranged into red, green, and blue COLOR
CHANNELS. The colorful Camera Raw histogram superimposes the red, green,
and blue channel graphs. When pixels contain all three color channels, the histogram is white. Cyan is the

combination of blue and green pixels. Yellow is the combination of red and green pixels. Magenta is the
combination of red and blue pixels.

CLIPPED COLORS are so close to either pure ?
black or pure white that they won't print with any | = =
detail. The Shadow clipping warning, activated

by clicking the small triangle in the top-left of the
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histogram, covers those image areas that are clipped to pure black with a bright blue overlay, as you can see in
this over-adjusted gull.

The Highlight clipping warning (small triangle in the top-right of the histogram) covers areas that are getting
close to white with a red overlay. With clipping on, you can decide if losing the detail in the affected areas will
adversely affect your image. Plus, as you make adjustments, you can see how those adjustments affect clipping.

© 0000000000000 0000c000000 0 00

Basic

THE ADJUSTMENTS PANE: BAsic Tas ,
White Balance: [AsShot 3]

The Adjustments pane is where you will make most of your Camera Raw adjustments. | Zrmeeme L=
It has ten tabs at its top, and each has a great many settings. In this course we will only = -
work with the Basic tab settings now, and the Detail settings later in the course. The e
Basic tab is where you will do most of your image adjustments. Cm“h 0
If you see different settings than these, Camera Raw is BFERERr = i C
not using the most recent settings. Before continuing, s Sslbaig :"k z
click the Camera Calibration tab, and choose 2012 Process: | 2012 (Current) 3 —

Clarity

(Current) from the Process drop down menu. —

Vibrance o

Saturation o

The Auto & Default Buttons

In the second section down in the Basic tab, there are two buttons, Auto and Default. They look like text links,
but are actually buttons.

Click Auto to perform an automatic correction. Sometimes Auto provides a fine starting point and at other
times Auto does not.

Try it and if Auto does not improve the image, click Default to return to the White Balance of the unadjusted
image. Default can be very helpful if your corrections get out of control.

White Balance

You already saw the White Balance Tool, which gives very precise control over | wnite Balance: [ shade B
which pixel sets the White Balance. In the Basic tab, the White Balance Temperature 7500
dropdown menu lets you choose from White Balance presets. A 1o

Here you set the neutral point of the image, to hopefully remove any

inappropriate color cast. You can also change the overall feel of the image, to make it feel |+ As Shot
warmer, cooler, or neutral. Auto
Daylight
As Shot sets the White Balance to what the camera used when the image was captured. Cloudy
Auto lets Camera Raw use pixel math to calculate the White Balance to give the best i:idg:ten
image, based on the overall image pixels. Note that the White Balance Auto setting does Flucrescent
not give the same results as the Auto button we looked at earlier. Elj::ﬂm

Daylight, Cloudy, and Shade adjust White Balance based on those exposure conditions.
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If you know you took the image on a cloudy day, for example, you might choose Cloudy.
Tungsten, Fluorescent, and Flash adjust based on those secondary light sources.

NOTE: JPEG and TIFF images opened in Camera Raw will only have three presets: As Shot, Auto, and Custom.

Temperature and Tint

Each White Balance setting changes the position of the Temperature and Tint sliders.
Temperature adjusts from cooler blue to warmer yellow.
Tint adjusts from green to magenta.

If you begin with one of the built-in White Balance settings, and then fine tune it with the Tint and/or
Temperature sliders, the White Balance menu setting will become Custom. Using the White Balance Tool
will also produce a Custom (White Balance) setting.

You can also drag the sliders manually to adjust overall image color. If you drag both the White Balance sliders to
the left, you shift the image towards both blue and green, or cyan. If you drag both sliders to the right, you increase
both yellow and magenta, making the image more red.

Tonal Adjustments

After you set your White Balance, you can use these additional sliders to enhance the tonality of your image.
Exposure adjusts the overall image brightness.

Contrast applies an S curve to lighten the highlights and darken the shadows without clipping the image’s
extreme lights and darks. Slide to the left to darken; slide to the right to lighten.

Highlights adjusts the brightest areas of the image. Dragging to the left darkens the highlights and can
often restore highlight details that are missing: CLIPPED or BLOWN OUT. Dragging to the right lightens
highlights.

Shadows adjusts the darkest areas of the image. Dragging to the left to darken shadows while minimizing
pure black, or CLIPPED details. Dragging to the right brightens shadows and reveals shadow detail.

Whites adjusts which values are mapped to white, similar to the highlights slider in the Levels dialog box.
Dragging to the left reduces highlight clipping, dragging to the right increases it to produce special effects
like specular highlights on metallic surfaces.

Blacks adjusts which values are mapped to black, similar to the shadow slider in the Levels dialog box.
Dragging to the left increases shadow clipping, dragging to the right reduces it.

Color Adjustments

Clarity adds depth to an image by increasing local contrast, especially in the midtones. Zoom in to at least
100% to see its effect. Increase Clarity until edge halos start to appear in transition areas, and then reduce
it slightly.
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Vibrance adjusts the saturation, with minimal clipping. It has less effect in higher-saturated colors, and
prevents skin tones from becoming oversaturated.

Saturation works like the Hue/Saturation adjustment within Photoshop, adjusting all colors equally. -100
will completely desaturate the image; +100 will double its saturation.

o0 e e e o000 00

OTHER TABS

Although we will only discuss the Detail tab later in the course, here is a quick rundown of the other
Adjustment tabs:

The Tone Curve tab allows you to apply a Curves command to the overall image tonality.

The Detail tab contains sections for sharpening and noise reduction.

The HSL/Grayscale tab is for making color adjustments, as well as converting to grayscale.

The Split Toning tab is used for adding color to grayscale images.

The Lens Corrections tab contains options for reducing chromatic aberration and lens vignetting.
The Effects tab is used for adding grain and vignetting to an image.

The Camera Calibration tab can be used for adjusting the color profiles associated with a given camera. It
also lets you choose which Process to use.

The Presets tab is where you can store your favorite settings.

The Snapshots tab allows you to store snapshots of your settings, like in the History panel.

RESET THE IMAGE

As you experiment with all the Camera Raw settings, it is easy for your adjustments to get out of control. To
revert to the image as opened (more powerful than the Default button for white point) press and hold alt or
option to temporarily change the Cancel button to the Reset button. With alt or option still pressed, click
Reset to revert to the original settings without closing the Camera Raw dialog box.

@000 0000000000000 0000 00 00

RecoGNizING AN ADJUSTED IMAGE

If you view an image that has been adjusted in Camera Raw inside of the Bridge Content pane, [y "
it will show one or more symbols in the upper right corner of its preview. Here the crop symbol ~ WET
on the left shows that the image was cropped, and the right symbol shows that it was adjusted.

One of the tremendous strengths of Camera Raw manipulations is that they are NON-DESTRUCTIVE, or
reversible. To restore an image to its original state, highlight it within the Bridge Content pane, and the choose
Edit > Develop Settings > Clear Settings.
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GuIDED EXERCISE 2.2: MANIPULATE AN IMAGE IN CAMERA Raw

In this guided exercise, you will open a JPEG file into Camera Raw, manipulate it to
improve it, and open it in Photoshop, and save an adjusted copy in PSD format.

1.

2.

10.

Launch Bridge if necessary.

Navigate to 02-TrollStart.jpg, right click on its thumbnail and choose Open with >
Camera Raw from the context menu that appears.

Wait until the yellow exclamation triangle disappears to be sure you can view all
your image pixels.

Identify the following regions of the Camera Raw dialog box:
+  Tools panel

+ Image Preview pane

« Histogram with Clipping Warning triangles

- Basictab

+ File handling buttons (Save Image, Open, etc.)

Click the Full Screen button in the Camera Raw window to enlarge your preview. The more of the image
you can see as you zoom in, the more precisely you can make your adjustments.

Turn the Highlights and Shadows Clipping Warnings on and see if you have clipping

in any areas of your image where detail loss will be detrimental.

Click the Auto button just above the Exposure slider. Your image gets lighter, and the|
white in the flag is less blue.

Toggle the Highlights Clipping Warning off and on, examining both the preview and its histogram in each
state.

With the Auto adjustment, the clipped area of the hat increases. With the clipping warning turned off, it
becomes harder to read Bergen on the hat. The shadow clipping is in insignificant shadow areas of the
background, that you will soon crop off. No problem there. But the troll’s hat has a large clipped area of
pretty solid light yellow. You will need to keep an eye on that area as you adjust the image.

Click the Default button to restore the original White Balance.

In the Adjustments pane, change the White Balance from As Shot to Auto (this is a different Auto from
step 7):

a. Use the Undo command to compare the image preview and the histogram. Use Undo again to restore
the adjustment.

Tutorial 2: Libraries & Camera Raw Page 29



b. Turn the Highlights and Shadows Clipping Warnings on and off to see if you have clipping in any
areas of your image where detail loss will be detrimental.

If this was a Raw image rather than a JPEG, there would have been more White Balance presets. See Resources
at the end of the tutorial for more information on the additional White Balance presets.

11. When you are done, go back to As Shot.
12. Crop the image so that it focuses on the troll:
a. Choose the Crop Tool.

b. Press the lower right corner of the Crop Tool icon to view the Crop Tool menu, and choose 1 to 1 at the
top of the menu. Since the troll is about as wide as heis tall, a 1 to 1 ratio will work fine here.

c. Dragin the Preview area to make a cropping rectangle, and drag the corners of the rectangle until you
are pleased with your results. To focus on the troll and not his distracting background, you will remove
quite a bit of the image as you crop it.

The area you will crop off is now SHIELDED or partially obscured. The shielded
area will be cropped off once the image is opened in Photoshop, but it is not
removed within Camera Raw. Non destructive cropping is a plus in case you

accidentally remove more of an image than you intended to, but it does keep the
file sizes large.

NOTE: we are cheating a bit here. The Canon Digital Rebel that shot the picture shot it at full 12
megapixel resolution. We downsampled the image to make a smaller file to speed its download time.

d. Hit the Enter or Return key to commit the crop.
13. Adjust the image tones:
a. Choose the White Balance Tool.

With the White Balance Tool, click on different areas of the troll that might be neutral, such as the
white in the flag, the grayish troll himself, or one of the dark shadow areas. As you do
keep an eye on the highlight clipping. We got our best results by clicking on a light
area in his big tooth.

b. Everything looks good except that hat, so let’s fix it with a tool you haven't seen yet,
the Adjustment Brush Tool.

14. Click the Done button to save the changes you made so far, and exit the Camera Raw dialog box.

THE ADJUSTMENT BRuUsH TooL j

The Adjustment Brush Tool lets you paint an adjustment selectively onto an image with one or more of the
sliders in the Basics tab. When you choose the Adjustments Brush Tool, the Basic tab changes so that you can
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configure your adjustment brushes. There is a lot of power in the Adjustments Brush Tool. You will just do a
simple adjustment, to lower the exposure of the troll’s yellow hat.
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IMAGE ADJUSTMENT WORKFLOW

Once you see how easy it is to use the Adjustment Brush Tool, you may be tempted to use it as your first step
to fix problem areas in images. That is not the most efficient way to work. Before proceeding, let’s review the
image adjustment workflow followed by most Photoshop professionals:

1. Obtain a digital image by either transferring it from your camera, or scanning it from film or from a printed
photograph.

2. Open the digital image within Photoshop, and choose File > Save As to save a working copy of the image
with a slightly different name. Do not alter the original, known as the ARCHIVAL VERSION, to preserve the
original in its pristine state.

3. Crop the working copy to reduce unwanted pixels from its perimeter, and straighten it if necessary.
4. Improve image tone and color as appropriate.

5. Fix localized problems.

6. Make “artistic” changes as desired.

7. Sharpen the image as appropriate.

8. Save and print.

9. Make a Web version if desired.

The Camera Raw workflow is a bit different.

= If you shoot in Camera Raw, that version is by its nature the archival version of your image because the
edits you make within the Raw dialog box are nondestructive. If you are going to process a JPEG, however,
consider making and saving a copy, to keep the original untouched in a different folder than your edited
images.

= You can crop, improve color and tone, and fix localized problems non-destructively from within the Camera
Raw dialog box.

= Since you can only process single layer images in Camera Raw, upon completion of your adjustments
phase, you should click Save and make a working .psd version of your image which you can then open in
Photoshop proper to add layers, apply filters, etc.
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GuiDED Exercise 2.3: Use THE ADJUSTMENT BRrusH ToolL

In this tutorial you will use the Adjustment brush to fix the exposure of the Troll’s hat.

1. Reopen 02-TrollStart.jpg.
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Since it has already been processed using Camera Raw, opening it using the Open command will open itin
Camera Raw.

Make sure that Highlights Clipping is turned on.

Choose the Adjustment Brush Tool.

Click the minus button to the left of the Exposure slider on the Agjustment Brsh
Adjustment Brush tab. B O Giee

. Exposure -0.50 .
Your Exposure changes to -0.50. Painting with this brush will lower your

exposure slightly.

Move the Adjustment Brush over the yellow hat.

You will see two concentric circles to show the brush size and the amount of
feathering (gradual reduction of its effect) on the outside. After you click the
mouse, there will be a pin to show the center point of your adjustment.

The clipped hat detail is restored, and the hat itself looks less washed |
out.

Click the Done button to update the changes you just made, and exit
Camera Raw.
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GuiDED ExerciSE 2.4: Process Your CAMERA Raw IMAGE 1

The Graduated and Radial Filter tools allow you to apply the same adjustments as with the
Adjustment Brush, but have the adjustments fade out in linear or radial gradients.

Here you will practice applying Graduated and Radial Filters.

1.
2.

Reopen 02-TrollStart.jpg.
Choose the Graduated Filter tool from the set of Camera Raw tools.

Let’s change the troll’s toes and ground below it to nice bright blue. Move the Temperature slider all the
way to the blue side, to -100.

Click just below its middle toe and

drag upward to to top of the toe. This
changes the ground below the troll to a
blue color, which fades as it approaches

the tops of the toes..

Experiment by moving the red and green dots placed by the Graduated Filter tool to expand, contract, or
change direction of the color transition.
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6. Next, let's lighten up the face of the troll. Reset the Temperature slider to zero, then click the plus sign to

T

the right of the Exposure slider to set Exposure to +0.50. Choose the ) - s

Radial Filter tool and click on the troll’s nose, dragging to just outside
of its head. This lightens the head slightly.

7. Drag the Exposure slider to the right, to about +1.30. This will lighten
up the area within the Radial Filter even more.

8. Experiment with dragging the handles along the red and white circle
outlining the Radial Gradient area.

9. Click Cancel to discard these changes.

oooooooooo

FinisHING Up
After you manipulate your image, you have four file handling choices along the bottom edge of the dialog box:
Save Image saves the image

in one of four file formats: DNG
(digital negative), JPEG, TIFF, or PSD, without closing the Camera Raw dialog box.

| Adabe RGB (1998); 8 bit; 5 by 5 inches; 240 ppi (openimage) (Cancel ) ( Done )

Open Image saves the settings, like Done, and then processes the image and opens it in Photoshop.
Cancel closes the Camera Raw dialog box without making any changes to the original image.

Done saves the image settings as an associated file without processing the file. This is convenient for batch
processing

ooooooooooooooooooooooooooooooooooooooooooooo

GuIDED EXERCISE 2.5: PRrOCESS YOUR CAMERA RAaw IMAGE 2

Here you will experiment with the processing choices for your image, and end up with a PSD working copy of
your adjusted image.

1. Reopen 02-TrollStart.jpg.

2. Examine the Workflow Options, underlined in purple at the bottom of the Camera Raw dialog box, and
adjust if needed. Adobe RGE (1998); 8 bit; 1069 by 1069 (1.1MP); 300 ppi

The Workflow Options specify the settings that Camera Raw will use to process the image when it Saves

Workfiow Options.

or Opens it: = —

<<<<<<<<<

a. Click the Workflow Options to display the Workflow Options
dialog box. e

b. Check the Resize to Fit box and set the width and height to the
desired size.

Open in Photoshop as Smart Objects

c. Confirm that the resolution is appropriate for your printer. It is set

to 300 ppi here, which is a good resolution for printing photographs on ink jet or laser printers.
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d. Click OK to accept these settings.

3. Follow these steps to save a PSD copy of your image:

a. Click the Save Image... button to view the options to convert and save a copy of your image.

b. Begin by choosing your destination. It should be

Save in New Location unless you want your original

and copy images to be in the same folder. The Select

Folder button will let you navigate to the desired
location.

¢. Name your file. Most digital cameras give sequence
names to their images, like image2956.jpg. You will
probably want to change this to a more meaningful

name.

d. Choose your format at the bottom of the dialog box. Your choices are PSD, JPEG, TIFF, and DNG.

Choose .psd here.

e. Ifyou are worried that your crop may be too severe, check Preserve Cropped Pixels. (It will make a

larger image than the cropped version.)

f.  Click Save. Although you saved a copy of your file, the source still stays open in Camera Raw for you to

Save Options

Destination: | Save in New Location B
’7 Select Folder... | /Users/laira/Deskiop!

oo

Metadata: | Al

[] Presarve Groppad Pixels

1
&
3
E
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o
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adjust a second version in a different way, and save it, if desired.

4. Open your adjusted image in Photoshop by clicking the Open Image button.

It may take a while, because Camera Raw needs to save your adjustments to the source image, close the
Camera Raw dialog box, and then open a copy of your adjusted image in Photoshop.

5. Choose File > Save As and save the working copy in PSD format in the location of your choice.

6. Think about the function of the two buttons we did not use:

Done processes your original image and closes the Camera Raw dialog box.

Cancel discards all the processing made in the current Camera Raw session, and closes both the image

and the Camera Raw dialog box.
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CAMERA RAw As A FILTER
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New since Photoshop CC 2014 is the ability to apply Camera Raw as a filter to any image. You have essentially
the same options as when using it as a plug-in, except that you do not have access to the Workflow Options or

File Handling options.

Camera Raw can also be applied as a Smart Filter. You will learn about Smart Objects and Smart Filters in the

next tutorial.
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oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

ON Your OwN

= Open 02-gull.jpg in Camera Raw. With Highlights and Shadows clipping turned on, Zoom in on the gull
and then play with the Basic tab to clip image highlights and shadows. Turn clipping on and off, so you can
see the loss of detail that clipping causes.

= Open 02-bird.jpg in Camera Raw and improve it by changing its white point and making other
adjustments with the Adjustment Brush Tool as desired. When you are done, save a PSD version.

= Open a Raw or JPG image of your own in Camera Raw and improve it by changing its white point if
needed, and other adjustments in the Basic tab as desired. When you are done, save a PSD version.

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

RESOURCES

http://www.practical-photoshop.com/pages/CC-2015-level2-resources.html#02
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